Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, or otherwise (including photocopying and recording), without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan, Republic of China.

PowerDirector is a registered trademark. Other company and product names mentioned in this publication are used for identification purposes, and shall remain the exclusive property of their respective owners.

International Headquarters: CyberLink Corporation, 15F, No.100, Min-Chiuan Road, Hsin-Tian City, Taipei Hsien, Taiwan, R.O.C.

Web site: support.gocyberlink.com
Telephone #: 886-2-8667-1298
Fax #: 886-2-8667-1467

Copyright © 2002 CyberLink Corporation, Taipei, Taiwan, ROC
# Table of Contents

## Introduction

- System Requirements
  - Hardware Requirements
- Supported File Formats

## Visual Overview

- PowerDirector Workspace
- 1. Library
- 2. Storyboard
- 3. Preview Window
- 4. Modes Wheel
- 5. Capture Mode
  - DV VCR Capture Mode
  - DV Batch Capture Mode
- 6. Trim Mode
- 7. Speed Mode
- 8. Titles Mode
- 9. Effects Mode
- 10. Picture-in-Picture Mode
- 11. Master Audio Mode
- 12. Audio Mode
- 13. Master Watermark Mode
- 14. Transitions Mode
The Basics................................................................................. 27

Basic Procedures......................................................................... 27
  PowerDirector Workspace......................................................... 27
  Working with Project Files......................................................... 28
  Importing Media Files into the Library.................................. 28
  Writing Movies to Tape............................................................... 28
  Editing in the Storyboard......................................................... 29
  Playing Movies........................................................................... 29
  Changing Modes......................................................................... 29
  Help............................................................................................... 29

Importing into the Library......................................................... 30
  Previewing your Library Files.................................................... 32
    Previewing in the Video Viewer............................................ 32
    Previewing in the Preview Window.................................. 33

Color Boards............................................................................... 34

Detecting Scenes......................................................................... 35

Storyboard Functions.................................................................... 38

Hotkey List.................................................................................. 41
  Basic Functions......................................................................... 41
  Modes Wheel............................................................................. 41
  Storyboard & Volume............................................................... 42
  Library...................................................................................... 42
  Preview Window Controls....................................................... 43
  Other.......................................................................................... 43

Preferences.................................................................................. 44
  General Preferences................................................................ 44
  Edit Preferences...................................................................... 46
  Display Preferences................................................................ 47
  Capture/Export Preferences.................................................. 48
  Preview Preferences................................................................ 50

Capturing Content..................................................................... 51

Capturing Video and Audio....................................................... 52
  Capturing from DV Camcorders............................................. 57
    Capturing from DV Camera Mode....................................... 58
    Capturing from DV VCR Mode............................................ 60
  Batch Capturing from DV Camcorders................................. 63

Trimming Video.......................................................................... 67

Trim Mode................................................................................... 67
  Splitting the Video File............................................................ 69
  Trim Mode for Image Files...................................................... 70
Altering Speed and Supplying Video Effects .......... 71
Altering Speeds ................................................................. 71
Supplying Video Effects ...................................................... 73

Adding Titles and Transitions ................................. 77
Titles Mode ................................................................. 77
Transitions Mode .......................................................... 81

Adding Audio and Pictures ................................. 83
Audio Mode ................................................................. 83
Master Audio .............................................................. 86
Picture-in-Picture Mode ............................................... 88
Master Watermark ........................................................ 91
Applying Image Color Filters ..................................... 92

Producing Your Movie ........................................... 93
Producing General MPEG-1 Files ....................... 94
Producing General MPEG-2 Files ....................... 97
Creating Custom MPEG Profiles ...................... 100
Producing Windows Media Files ....................... 102
Producing AVI Files ..................................................... 105
Writing to DV Tape ..................................................... 108
Setting AVI Profiles .................................................. 110
Producing QuickTime Movie Files .................. 112
Creating Custom QuickTime Movie Profiles .... 114
Producing RealVideo Files ..................................... 116
Creating Custom RealVideo Profiles ................ 118
Producing Movies on a Disc ................................. 119
CHAPTER 1: INTRODUCTION

Ever thought about directing your own movie? How about having all the creative controls and being in charge of the entire editing and post-production process? Well, today’s computing technology has made all this possible for anyone who has recording devices, capture devices, a computer, and of course, the sensational new software application, PowerDirector.

Admittingly, video editing software is not without its drawbacks. Since the advent of computers and its incredible growth in usage and processing speed power, video editing software applications have taken off to astronomical heights. Yet, a great inherent limitation, such as requiring a huge amount of disk space because of the raw video data it captures, still remains. This is why many still choose to edit with analog devices.

What makes PowerDirector the megastar of its industry in one quick flash is its ability to save precious producing time because of its Smart Video Rendering Technology (SVRT). No additional compression nor decompression is required when producing scenes with MPEG or DV AVI formats that do not contain effects, which saves you huge amounts of time compared to our competitors that compress and decompress the entire movie regardless!
PowerDirector offers wonderful features that simply enthrall, amaze and stupefy including:

- altering video speeds
- detecting scenes
- *capturing directly from DV camcorders in real-time or non real-time
- a Disc Wizard that creates and burns movie discs a cinch!
- adding titles to clips
- adding audio streams to clips
- *picture-in-pictures (adding video or images to an existing video clip)
- *a huge collection of transitions, video and titles effects
- *master audio files
- *watermarks

...and there is nothing left to be desired!

*Note:* Features marked by an asterix (*) may differ in availability or number, depending on the version of PowerDirector that you have. To get the full version, please visit www.gocyberlink.com.
System Requirements

- Windows 98SE, ME, 2000, XP

Hardware Requirements
- Pentium II 450 or above

Note: For hardware requirements when capturing from your DV camcorder or analog devices, please refer to the most up-to-date Readme.

- 200MB of free hard drive disk (HDD) space
- Video capture devices (optional)
  - capture cards (PCI, USB, FireWire or other FireWire formats)
  - DV camcorder or DV VCR
  - analog camcorders or VCRs in 8mm, Hi8, VHS, VHS-C or Beta formats
  - digital camera
  - PC camera
- Playback
  - Internet Streaming: Pentium II 266 with MMX Technology, Microsoft Windows Media Player 7.0, IE 5.0
  - Desktop Slide Show: Pentium II 266 with MMX Technology
# Supported File Formats

The following formats are supported by PowerDirector for input and output.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image</strong></td>
<td>BMP</td>
<td>BMP</td>
</tr>
<tr>
<td></td>
<td>GIF</td>
<td>GIF</td>
</tr>
<tr>
<td></td>
<td>JPG</td>
<td>JPG</td>
</tr>
<tr>
<td></td>
<td>TIF</td>
<td></td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>Windows AVI</td>
<td>Windows AVI</td>
</tr>
<tr>
<td></td>
<td>DV AVI</td>
<td>DV AVI</td>
</tr>
<tr>
<td></td>
<td>MPEG-1</td>
<td>MPEG-1</td>
</tr>
<tr>
<td></td>
<td>MPEG-2</td>
<td>MPEG-2</td>
</tr>
<tr>
<td></td>
<td>RealVideo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>QuickTime</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WMV</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 2: VISUAL OVERVIEW

This section describes the PowerDirector user’s interface, along with its key elements. The four major elements of the PowerDirector interface include:

- the Library
- the Storyboard
- the Preview Window
- the Modes Wheel

In the image of the PowerDirector workspace that follows, these four elements are indicated by numbers (1-4), which correspond to sections that describe each of these elements in more detail. Each of these sections, in turn, contains a graphic with callouts and a table that contains descriptions of each of their elements.
Chapter 2

PowerDirector Workspace

1 2 3 4  A  B  C  D  E
<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Library</td>
<td>Contains raw media files for use in the Storyboard</td>
</tr>
<tr>
<td>2 Storyboard</td>
<td>Contains finalized media clips, transitions, effects, and user settings that combine to create a movie</td>
</tr>
<tr>
<td>3 Preview Window</td>
<td>Allows users to preview media clips, transitions, and special effects</td>
</tr>
<tr>
<td>4 Modes Wheel</td>
<td>Switches between editing modes</td>
</tr>
<tr>
<td>A i-Power</td>
<td>Activates i-Power on the Web for resources</td>
</tr>
<tr>
<td>B Minimize</td>
<td>Minimizes PowerDirector</td>
</tr>
<tr>
<td>C Exit</td>
<td>Exits PowerDirector</td>
</tr>
<tr>
<td>D Trash Can</td>
<td>Deletes media clips in the Library or the Storyboard</td>
</tr>
<tr>
<td>E Volume</td>
<td>Adjusts volume</td>
</tr>
</tbody>
</table>
1. Library

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Show All Media</td>
</tr>
<tr>
<td>B</td>
<td>Show Video</td>
</tr>
<tr>
<td>C</td>
<td>Show Audio</td>
</tr>
<tr>
<td>D</td>
<td>Show Images</td>
</tr>
<tr>
<td>E</td>
<td>Show Color Boards</td>
</tr>
<tr>
<td>F</td>
<td>Detect Scenes</td>
</tr>
<tr>
<td>G</td>
<td>Import Media</td>
</tr>
<tr>
<td>H</td>
<td>Import Directory</td>
</tr>
<tr>
<td>I</td>
<td>Thumbnails</td>
</tr>
<tr>
<td>J</td>
<td>Details</td>
</tr>
</tbody>
</table>
Color Boards Mode

A New Color Board
- Shows the default Color Boards in the Library

B Restore Default Color Boards
- Removes customized Color Boards and reverts to the default Color Boards
## 2. Storyboard

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Play Movie (preview before producing)</td>
</tr>
<tr>
<td>B</td>
<td>Master Watermark (Activates Master Watermark mode)</td>
</tr>
<tr>
<td>C</td>
<td>Master Audio (Activates Master Audio mode)</td>
</tr>
<tr>
<td>D</td>
<td>Scroll Left (Scrolls Storyboard left)</td>
</tr>
<tr>
<td>E</td>
<td>Scroll Right (Scrolls Storyboard right)</td>
</tr>
</tbody>
</table>
### 3. Preview Window

![Preview Window Image](image)

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td>Stops playing file</td>
</tr>
<tr>
<td>B</td>
<td>Play/Pause</td>
</tr>
<tr>
<td></td>
<td>Plays/pauses file</td>
</tr>
<tr>
<td>C</td>
<td>Start</td>
</tr>
<tr>
<td></td>
<td>Jumps to start of file</td>
</tr>
<tr>
<td>D</td>
<td>Apply</td>
</tr>
<tr>
<td></td>
<td>Applies clip to Storyboard (if applicable)</td>
</tr>
<tr>
<td>E</td>
<td>End</td>
</tr>
<tr>
<td></td>
<td>Jumps to end of file</td>
</tr>
<tr>
<td>F</td>
<td>Previous Frame</td>
</tr>
<tr>
<td></td>
<td>Moves to previous frame</td>
</tr>
<tr>
<td>G</td>
<td>Next Frame</td>
</tr>
<tr>
<td></td>
<td>Moves to next frame</td>
</tr>
<tr>
<td>H</td>
<td>Record</td>
</tr>
<tr>
<td></td>
<td>Records file (if applicable depending on mode)</td>
</tr>
</tbody>
</table>

**Note:** Durations are displayed as HH:MM:SS:FF (i.e. hours:minutes:seconds:frames).
4. Modes Wheel

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Preview Mode</td>
</tr>
<tr>
<td>B</td>
<td>Trim Mode</td>
</tr>
<tr>
<td>C</td>
<td>Speed Mode</td>
</tr>
<tr>
<td>D</td>
<td>Titles Mode</td>
</tr>
<tr>
<td>E</td>
<td>Effects Mode</td>
</tr>
<tr>
<td>F</td>
<td>PiP Mode</td>
</tr>
<tr>
<td>G</td>
<td>Audio Mode</td>
</tr>
<tr>
<td>H</td>
<td>Transitions Mode</td>
</tr>
<tr>
<td>I</td>
<td>Capture Mode</td>
</tr>
<tr>
<td>J</td>
<td>Disc Wizard</td>
</tr>
<tr>
<td>K</td>
<td>Produce Movie</td>
</tr>
</tbody>
</table>

Switches to the default Preview Mode
Switches to Trim Mode
Switches to Speed Mode
Switches to Titles Mode
Switches to Effects Mode
Switches to Picture-in-Picture (PiP) Mode
Switches to Audio Mode
Switches to Transitions Mode
Switches to Capture Mode
Switches to Disc Wizard
Switches to Produce Movie
Capture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Audio Capture</td>
</tr>
<tr>
<td></td>
<td>Captures audio source only</td>
</tr>
<tr>
<td>B</td>
<td>Analog Video Capture</td>
</tr>
<tr>
<td></td>
<td>Captures analog video and audio source (if applicable)</td>
</tr>
<tr>
<td>C</td>
<td>DV Capture</td>
</tr>
<tr>
<td></td>
<td>Captures DV source</td>
</tr>
<tr>
<td>D</td>
<td>Video Setup</td>
</tr>
<tr>
<td></td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>E</td>
<td>Profile Setup</td>
</tr>
<tr>
<td></td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>F</td>
<td>Audio Setup</td>
</tr>
<tr>
<td></td>
<td>Setup for audio/video sources and profiles</td>
</tr>
</tbody>
</table>
Chapter 2

DV VCR Capture Mode
<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Stop</td>
<td>Stops recording file (may also stop DV tape playback)</td>
</tr>
<tr>
<td>B Play</td>
<td>Plays file</td>
</tr>
<tr>
<td>C Current Tape Timecode</td>
<td>Denotes current time position of your DV tape</td>
</tr>
<tr>
<td>D Total Time</td>
<td>Denotes total time captured from DV tape</td>
</tr>
<tr>
<td>E Pause</td>
<td>Pauses file</td>
</tr>
<tr>
<td>F Seek</td>
<td>Seeks tape’s timecode</td>
</tr>
<tr>
<td>G Rewind</td>
<td>Rewinds DV tape</td>
</tr>
<tr>
<td>H Fast Forward</td>
<td>Fast forwards DV tape</td>
</tr>
<tr>
<td>I Previous Frame</td>
<td>Goes to DV tape’s previous frame</td>
</tr>
<tr>
<td>J Shuttle</td>
<td>Shuttles DV tape</td>
</tr>
<tr>
<td>K Next Frame</td>
<td>Goes to DV tape’s next frame</td>
</tr>
<tr>
<td>L Record</td>
<td>Records/captures DV tape content</td>
</tr>
<tr>
<td>M Non Real-time/Real-time Capture</td>
<td>Captures in non real-time (default) or real-time</td>
</tr>
<tr>
<td>N Instant Capture Mode</td>
<td>Switches to Instant Capturing Mode (not pictured)</td>
</tr>
<tr>
<td>O Snapshot</td>
<td>Takes an instant snapshot</td>
</tr>
<tr>
<td>P Batch Capture Mode</td>
<td>Switches to Batch Capturing Mode</td>
</tr>
<tr>
<td>Q Video Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>R Profile Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>S Audio Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
</tbody>
</table>
Chapter 2

DV Batch Capture Mode
<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Stop</td>
<td>Stops batch capturing</td>
</tr>
<tr>
<td>B Mark In</td>
<td>Marks in for beginning of batch task</td>
</tr>
<tr>
<td>C Current Tape Timecode</td>
<td>Denotes current time position of your DV tape</td>
</tr>
<tr>
<td>D Seek</td>
<td>Seeks tape’s timecode</td>
</tr>
<tr>
<td>E Rewind</td>
<td>Rewinds DV tape</td>
</tr>
<tr>
<td>F Fast Forward</td>
<td>Fast forwards DV tape</td>
</tr>
<tr>
<td>G Mark Out</td>
<td>Marks out for beginning of batch task</td>
</tr>
<tr>
<td>H Shuttle</td>
<td>Shuttles DV tape</td>
</tr>
<tr>
<td>I Non Real-time/Real-time Capture</td>
<td>Captures in non real-time (default) or real-time</td>
</tr>
<tr>
<td>J Instant Capture Mode</td>
<td>Switches to Instant Capturing Mode (not pictured)</td>
</tr>
<tr>
<td>K Add Task</td>
<td>Adds new batch capturing task</td>
</tr>
<tr>
<td>L Remove Task</td>
<td>Removes batch capturing task</td>
</tr>
<tr>
<td>M Batch Capture Mode</td>
<td>Switches to Batch Capturing Mode</td>
</tr>
<tr>
<td>N Start Selected Task(s)</td>
<td>Starts selected batch capturing task(s)</td>
</tr>
<tr>
<td>O Video Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>P Audio Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
<tr>
<td>Q Profile Setup</td>
<td>Setup for audio/video sources and profiles</td>
</tr>
</tbody>
</table>
Trim Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Mark In</td>
<td>Marks in for beginning of trimmed clip</td>
</tr>
<tr>
<td>B Time Slider Position</td>
<td>Denotes current time slider position</td>
</tr>
<tr>
<td>C Mark Out</td>
<td>Marks out for end of trimmed clip</td>
</tr>
<tr>
<td>D Total Time</td>
<td>Total time of trimmed clip</td>
</tr>
<tr>
<td>E Split Video</td>
<td>Splits current clip into two at the time slider position</td>
</tr>
<tr>
<td>F Revert</td>
<td>Reverts to clip’s original trim effects</td>
</tr>
<tr>
<td>G Snapshot</td>
<td>Takes snapshot</td>
</tr>
<tr>
<td>H Clear</td>
<td>Clears all trim effects</td>
</tr>
</tbody>
</table>
Speed Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Decrease Speed</td>
</tr>
<tr>
<td>B</td>
<td>Revert</td>
</tr>
<tr>
<td>C</td>
<td>Clear</td>
</tr>
<tr>
<td>D</td>
<td>Increase Speed</td>
</tr>
</tbody>
</table>

- A Decrease Speed decreases the speed of the video.
- B Revert reverts the video to its original speed effects.
- C Clear clears all speed effects.
- D Increase Speed increases the speed of the video.
# Titles Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Mark In</td>
</tr>
<tr>
<td></td>
<td>Marks in for beginning of title effect</td>
</tr>
<tr>
<td>B</td>
<td>Mark Out</td>
</tr>
<tr>
<td></td>
<td>Marks out for end of title effect</td>
</tr>
<tr>
<td>C</td>
<td>TV Safe Zone</td>
</tr>
<tr>
<td></td>
<td>Displays a dashed outline around the inside of the Preview Window</td>
</tr>
<tr>
<td>D</td>
<td>Grid Lines</td>
</tr>
<tr>
<td></td>
<td>Displays a grid of dashed lines</td>
</tr>
<tr>
<td>E</td>
<td>Add Title</td>
</tr>
<tr>
<td></td>
<td>Adds new title to clip</td>
</tr>
<tr>
<td>F</td>
<td>Remove Title</td>
</tr>
<tr>
<td></td>
<td>Removes title from clip</td>
</tr>
<tr>
<td>G</td>
<td>Revert</td>
</tr>
<tr>
<td></td>
<td>Reverts to clip’s original title effects</td>
</tr>
<tr>
<td>H</td>
<td>Set Font</td>
</tr>
<tr>
<td></td>
<td>Sets font options</td>
</tr>
<tr>
<td>I</td>
<td>Clear</td>
</tr>
<tr>
<td></td>
<td>Clears all title effects</td>
</tr>
</tbody>
</table>
# Effects Mode

![Image of Effects Mode interface]

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Link Settings</td>
</tr>
<tr>
<td></td>
<td>Links two given settings</td>
</tr>
<tr>
<td>B</td>
<td>Revert</td>
</tr>
<tr>
<td></td>
<td>Reverts to clip’s original video effects</td>
</tr>
<tr>
<td>C</td>
<td>Clear</td>
</tr>
<tr>
<td></td>
<td>Clears all video effects</td>
</tr>
</tbody>
</table>
### Picture-in-Picture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A TV Safe Zone</td>
<td>Displays a dashed outline around the inside of the Preview Window</td>
</tr>
<tr>
<td>B Grid Lines</td>
<td>Displays a grid of dashed lines</td>
</tr>
<tr>
<td>C Revert</td>
<td>Reverts to clip’s original picture effects</td>
</tr>
<tr>
<td>D Trim Video</td>
<td>Allows you to trim a video file used as the second picture</td>
</tr>
<tr>
<td>E Clear</td>
<td>Clears all picture effects</td>
</tr>
<tr>
<td>F Eyedropper</td>
<td>Selects image color to be filtered</td>
</tr>
</tbody>
</table>
Master Audio Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Volume Mixing Drag slider for mixing volume for user-defined audio files (0-200%)</td>
</tr>
<tr>
<td>B</td>
<td>Add Audio Adds new audio file to clip</td>
</tr>
<tr>
<td>C</td>
<td>Revert Reverts to clip’s original audio effects</td>
</tr>
<tr>
<td>D</td>
<td>Remove Audio Removes audio file from clip</td>
</tr>
<tr>
<td>E</td>
<td>Trim Audio Allows you to trim an audio file</td>
</tr>
<tr>
<td>F</td>
<td>Clear Clears all audio effects</td>
</tr>
</tbody>
</table>
Chapter 2

Audio Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Volume Mixing: Drag slider for mixing volume for user-defined audio files (0-200%)</td>
</tr>
<tr>
<td>B</td>
<td>Add Audio: Adds new audio file to clip</td>
</tr>
<tr>
<td>C</td>
<td>Revert: Reverts to clip’s original audio effects</td>
</tr>
<tr>
<td>D</td>
<td>Remove Audio: Removes audio file from clip</td>
</tr>
<tr>
<td>E</td>
<td>Trim Audio: Trims audio file</td>
</tr>
<tr>
<td>F</td>
<td>Clear: Clears all audio effects</td>
</tr>
</tbody>
</table>
# Master Watermark Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A TV Safe Zone</td>
<td>Displays a dashed outline around the inside of the Preview Window</td>
</tr>
<tr>
<td>B Grid Lines</td>
<td>Displays a grid of dashed lines</td>
</tr>
<tr>
<td>C Revert</td>
<td>Reverts to clip’s original transition effects</td>
</tr>
<tr>
<td>D Clear</td>
<td>Clears all transition effects</td>
</tr>
<tr>
<td>E Eyedropper</td>
<td>Selects image color to be filtered</td>
</tr>
</tbody>
</table>
Chapter 2

Transitions Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Decrease Transition Length</td>
</tr>
<tr>
<td>B</td>
<td>Revert</td>
</tr>
<tr>
<td>C</td>
<td>Clear</td>
</tr>
<tr>
<td>D</td>
<td>Increase Transition Length</td>
</tr>
</tbody>
</table>

**A** Decrease Transition Length: Decreases time for the selected transition

**B** Revert: Reverts to clip’s original transition effects

**C** Clear: Clears all transition effects

**D** Increase Transition Length: Increases time for the selected transition
CHAPTER 3: THE BASICS

It’s time to get started with the basics before your mesmeric and uninhibited effects are added. The ensuing sections will outline how to begin by importing your media files into the PowerDirector Library and previewing these files. You will also learn how to use Color Boards in the Storyboard and how to detect scenes within a video file. Later, you will get accustomed to the Storyboard and then wrap things up with choosing your specific Preferences.

Basic Procedures

Below are brief descriptions of various functions. For more information, please follow their links.

PowerDirector Workspace

- To close PowerDirector, do one of the following:
  - choose File > Exit
  - press Ctrl+Q
  - click the Exit button in the top right-hand corner
- Click the Minimize button in the top right-hand corner to minimize the PowerDirector workspace.
Chapter 3

Working with Project Files

- If you want to create a new project, choose **New Project**.
- Choose **Open Project...** to open an existing project.
- Choose **Save Project** to save your project.
  - Choose **Save Project As...** to rename the project.
- Choose **Project Properties...** to add more information about your movie.
  - You might want to fill out **Keyword**, which is suitable for database searches, or any other fields.
- Choose **Recent Files** to select a project you had recently been modifying.

Importing Media Files into the Library

The **File > Import** command serves the same function as **Import Media** in importing media files to your project’s Library.

You may import **Media Files...**, **Media Folder...**, or **Files from Another Project...**

- For the latter, select another project and click **Open** to import another project’s media files. Refer to “Importing into the Library” on page 30 for more details.

Writing Movies to Tape

For the **File > Write to DV Tape...** function, a quick and easy way is to do the following:

1. Select a DV AVI file directly from the Library and then choose **File > Export > Write to DV Tape...** for instant writing. A dialog box appears.
2. Click **Show Preview** to preview when writing and then click **Start**.
3. Click **Close** when complete.

To write multiple files to a DV tape, do the following:

1. Drag the DV AVI files from the Library to the Storyboard. It is imperative that you do not add any effects and that all Storyboard clips are in DV AVI format.
2. Now, with a DV AVI file selected on the Storyboard, choose **File > Export > Write to DV Tape...** The Storyboard order will be the sequence in which they will be written to DV tape.
3. Click **Show Preview** to preview when writing and then click **Start**.
4. Click **Close** when complete. For more information on writing to DV tape when producing, please refer to "Producing AVI Files" on page 105 for more information.
Editing in the Storyboard

The basic editing commands are if a clip is selected in the Storyboard: **Cut, Copy, Paste** or **Delete**.

You may also set the **Mark In/Mark Out** positions, and perform other editing functions.

Playing Movies

Use the commands found in the **Playback** menu for full playback controls, including: **Play/Pause, Stop, Go to Start, Go to End**.

Changing Modes

Select a clip and then any one of the Modes under the **Go To** menu. This has the same effect as clicking the icons on the Modes Wheel, the Master Audio or Master Watermark icons on the Storyboard, or the Color Boards icons in the Library. Go to the individual sections for more details on specific Modes.

Help

Under the **Help** menu, you will find any help you might need that will include the following:

- PowerDirector Help...
- Search for Help Topic...
- Help Index...

You may also choose from the following services:

- Register PowerDirector...
- Download Upgrades...
- Online Support Web Site...
- i-Power Web Site... for resources
- CyberLink Web Site...
Chapter 3

Importing into the Library

The first step in almost all video editing software applications is to import media files into the software application itself. This area of the software application where the imported files reside is the Library. When you first start PowerDirector, several media files appear in the Library by default.

1 After you have started the PowerDirector application, click Import Media or choose File > Import > Media Files...

   - Click Import Directory to import all media files in a given directory. Select the folder and click OK.

2 Select the files to be imported by clicking. To select multiple files, press <Shift> while clicking to select continuous files or press <Ctrl> while clicking to select discontinuous files.

3 Click Open. The file(s) will now be imported to PowerDirector’s Library.

   - To show all media files, all video files, all audio files, or all image files, click the appropriate icon in the top left corner.

   - The files will appear in the Library. Click Thumbnails or click Details to change the view to a text view along with some of its associated file properties.

   **Note:** If you change the view to Details, you can sort media clips by Name, Duration, or Date (of creation) by clicking the appropriate column heading. Note that still images do not have an inherent duration.

   - You may also right-click on a specific file for a menu. Select one of the options to Preview, Play in Video Viewer, Apply to Storyboard, Remove from Library, View Scenes or Detect Scenes. Please refer to the appropriate sections for more information.
Right-click anywhere in the Library area when no files are selected for another menu. Here, you may change your view, import files, sort, Select All, and also choose Up One Level if you are in a scenes subfolder. Go to "Detecting Scenes" on page 35 for more information.

To remove files from the Library, select them and click the Trash Can to delete. (You may also drag the selected files to the Trash Can, press the <Delete> key on your keyboard, or right-click on one of the files and select Remove from Library.) A warning prompt appears, asking if you would like to delete the files from your hard drive, too. Click Yes to remove the files from both the Library and your hard drive or No to remove them only from the Library.
Previewing your Library Files

Previewing Library files simply plays your original files like any other Media Player. There are two methods for previewing Library files, which are described below.

Previewing in the Video Viewer

1. After you have imported your files into the Library, right-click on the file for a menu.

2. Select **Play in Video Viewer**. The file will instantly appear in the Video Viewer. Play controls allow you to navigate forward or backward in the video file.

- You can resize the Video Viewer window by dragging any of the borders. If you want to restore the original dimensions of the window, click the **Restore** button.

![Video Viewer](image-url)
Previewing in the Preview Window

1. After you have imported your files into the Library, begin previewing by dragging the files into the Preview Window or double-clicking on them. The mode will instantly switch to Preview.

2. Click Play to begin playing your file if it’s a video or audio clip.
   - You may also skip directly to the Start or to the End.
   - Other common commands are Pause, Stop, Next Frame and Previous Frame. The best way to utilize the Next Frame and Previous Frame commands are during the Pause and Stop modes. However, you may click them during playback, which will then switch into Pause mode.
   - Drag and release the Time Slider to navigate quicker when previewing your file.
   - You may also right-click on the Preview Window for a shortcut menu. Select one of the preview options or Apply to Storyboard.

3. If you are satisfied with your file and don’t require any further manipulation, click Apply and the file will be applied to your Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
Chapter 3

Color Boards

Color Boards allow you to insert solid frames of color into the Storyboard or into other files in Picture-in-Picture or Master Watermark Mode. Color Boards are not media files as such, and cannot be previewed or sorted. However, they can be applied directly to the Storyboard, used in the foreground or the background of image and video files, and added to or deleted from the Library.

1. Click Show Color Boards in the Library. The default Color Boards appear in the Library.

2. Drag-and-drop a Color Board into the Storyboard or into the frame in Picture-in-Picture or Master Watermark Mode. (See "Picture-in-Picture Mode" on page 88.) Once applied in the Storyboard, Color Boards behave like any other image file.

   To create a customized Color Board, click New Color Board. A standard Windows Color dialog box opens, allowing you to select from a palette of basic colors, or define a customized color. When you click OK, the new Color Board will appear in the Library.

   To remove your customized Color Boards and revert to the default Color Boards, click Restore Default Color Boards. A prompt will appear to ask if you want to revert to the default settings. Click Yes and the Color Boards you have defined will be removed from the Library.

Note: Color Boards only appear in the Library when you click Show Color Boards.
Detecting Scenes

Scene detection automatically creates individual files based on the original file’s scenes allowing users to utilize existing video files to their maximum. Even after you are finished detecting scenes for a certain file, you can further divide its scenes an infinite number of times.

1. After you have imported your files into the Library, select a video file and click Detect Scenes and the Detect Scenes window will appear.

2. Drag the Sensitivity slider or click Increase/Decrease Sensitivity. The more sensitive the setting, the more scenes it will detect which will generate more video files.

- For previewing functionality, go to "Previewing your Library Files" on page 32 for more information.
Chapter 3

- Click Advanced Settings for modification before detecting scenes.
  - The Detection Method section is for captured video content that has been imported into the Library. Go to “Capturing from DV Camcorders” on page 57 for information on capturing content from a DV camcorder. Use the default unless you have a DV AVI format file that contains multiple timecodes (i.e. resetting of timecodes are automatically set when you start and stop recording) and you wish to split up your files in this manner, select Detect by changing of timecodes.

![Advanced Settings for Scene Detection](image)

**Note:** If you have selected Detect by changing of timecodes, in essence, PowerDirector will not be performing the scene detection feature, for scenes that are detected will rely solely on the DV tape’s changing of timecodes, which is ultimately dependent on the DV tape itself.

- To detect more precisely for video content that contains fades (used to delicately move from scene-to-scene), be sure that Ignore fade ins/outs are checked. Otherwise, erroneous scenes may be detected that will include fades.
- To detect more precisely, be sure that Ignore flashing lights (e.g. camera flash) is checked. Otherwise, erroneous scenes may be detected that will include flashing lights. Click OK.

3. Use the navigation buttons or drag the Time Slider to the position where you would like to begin detecting scenes. (You may, of course, detect scenes from the start of the clip.)

4. Click Detect. The media clip plays in the Preview Window.
- Click the Stop toggle or the <Esc> key to end the scene detection process, or let the clip play to the end.
- After the original scene detection, you may detect again for an infinite number of times! Simply select a scene, repeat all the steps including selecting a sensitivity setting, and then click Detect again!
To split your own scenes, drag the slider to the desired position and click **Split**. The new scene will be comprised of the video content after the split position. Repeat this procedure to create more scenes. To split from the original video file again, click outside of the scenes and the Preview Window will display the original video file.

To remove scenes after detection, select the scene and click **Merge With Previous** or **Remove All**. If you click the Remove All button, a warning message appears, asking whether you want to remove all of the scenes from the Library. Click Yes to remove the scenes, or No to cancel the operation.

**Note:** When removing scenes, content from the removed scene will be merged into the previous scene automatically, except for the first scene, which will merge with the following scene.

You may also select a scene and right-click for a menu. Choose **Remove Scene** to remove or **Detect Again from this Scene** to detect additional scenes from this specific scene and generate even more files/scenes!

5. After the scenes are created, click **OK** to return to PowerDirector or click **Cancel**.

The new scene files will now be displayed in the Library in a subfolder. To return to the Library, click **Up One Level**.

A small folder icon will be displayed for all Library files that have undergone scene detection and which possess additional scene files. Simply click on the icon to access the scene’s subfolder for a specific Library file.
Storyboard Functions

When you produce, you are producing all the clips on your Storyboard. If you don’t have any files applied onto the Storyboard, you can’t produce your movie! Thus, the Storyboard is the most important facet and area of your entire pre-production.

Keep in mind that not all files have to be manipulated, for files may be directly applied or dragged onto the Storyboard immediately after being imported into the Library. Go to "Importing into the Library" on page 30 for more information.

1 Now that your files have been imported into the Library and you have previewed them, you can directly drag the media files into the Storyboard without further manipulation and produce your own movie. A red line will appear so as to convey where the dragged file will be placed.

Note: Audio files may not be applied individually onto the Storyboard unless it is for the Master Audio or as an audio supplement to an existing clip.

2 To move multiple clips on the Storyboard, simply hold down the <Shift> key while clicking the clips you want to move together. The clips will be highlighted. Now, drag and release onto the new position.
To remove clips from the Storyboard, select them and click Trash Can to delete. (You may also drag the selected files to the Trash Can, press the <Delete> key on your keyboard, or right-click on one of the files and select Cut from Storyboard or Remove from Storyboard.) If you select any of these options except Cut from Storyboard, a prompt appears, asking if you would like to remove the file from the Storyboard. Click Yes to remove the file from the Storyboard, or No to abort the deletion process.

To preview or to manipulate a clip from the Storyboard, select it by double-clicking and it will appear in the Preview window. Refer to "Previewing your Library Files" on page 32 for more information.

You may also right-click on a specific clip in the Storyboard for a menu. Select one of the options that will include cutting, copying or pasting clips on the Storyboard.

Click anywhere other than a clip on the Storyboard and a more diverse menu will be displayed that will include Storyboard display and also Go to options. Select one.
4 Click **Play Movie**  to view clips on your Storyboard before producing. You may select your options in the Preview section under **Edit > Preferences**... Go to "Preview Preferences" on page 50 for more information. Or, you may right-click on the Play Movie icon to call up a shortcut menu that will allow you to set the window size during your movie playback.

![Play Movie Options](image)

---

**Note:** Playing the movie is not the final step in your movie-making process and is only a preview of your production. Remember to produce your movie!

- During the movie playback, press <Esc> on your keyboard to quit or double-click.
- Two other icons are located on the Storyboard. For more information on **Master Watermark** or **Master Audio**, go to "Master Watermark" on page 91 and "Master Audio" on page 86 for more information.

5 If you are satisfied with all your clips and your movie, click **Produce Movie**  on the Modes Wheel. Refer to "Producing Your Movie" on page 93.
Hotkey List

The following tables display the hotkey combinations that can be used in PowerDirector.

### Basic Functions

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Space</td>
<td>Opens the Minimize menu</td>
<td>Ctrl+N</td>
<td>New Project</td>
</tr>
<tr>
<td>Alt+E</td>
<td>Opens the Edit menu</td>
<td>Ctrl+O</td>
<td>Open Project</td>
</tr>
<tr>
<td>Alt+F</td>
<td>Opens the File menu</td>
<td>Ctrl+Q</td>
<td>Exit Program</td>
</tr>
<tr>
<td>Alt+G</td>
<td>Opens the Go To menu</td>
<td>Ctrl+S</td>
<td>Save Project</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Opens the Help menu</td>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Alt+P</td>
<td>Opens the Playback menu</td>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Alt+T</td>
<td>Opens the Capture menu</td>
<td>Delete</td>
<td>Delete active item</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Opens the View menu</td>
<td>Esc</td>
<td>Stops current action</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select All (Library, Scene Detection)</td>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
<td>Shift+Ctrl+S</td>
<td>Save Project As</td>
</tr>
</tbody>
</table>

### Modes Wheel

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Switches to Capture Mode</td>
<td>F8</td>
<td>Switches to Picture-in-Picture (PiP) Mode</td>
</tr>
<tr>
<td>F3</td>
<td>Switches to the default Preview Mode</td>
<td>F9</td>
<td>Switches to Audio Mode</td>
</tr>
<tr>
<td>F4</td>
<td>Switches to Trim Mode</td>
<td>F10</td>
<td>Switches to Transitions Mode</td>
</tr>
<tr>
<td>F5</td>
<td>Switches to Speed Mode</td>
<td>F11</td>
<td>Switches to Produce Movie</td>
</tr>
<tr>
<td>F6</td>
<td>Switches to Titles Mode</td>
<td>F12</td>
<td>Switches to Disc Wizard</td>
</tr>
<tr>
<td>F7</td>
<td>Switches to Effects Mode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Storyboard & Volume

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl +</td>
<td>Increases Volume</td>
<td>Ctrl+Backspace</td>
<td>Mutes volume</td>
</tr>
<tr>
<td>Ctrl -</td>
<td>Decreases Volume</td>
<td>Shift+End</td>
<td>Goes to last clip on the Storyboard</td>
</tr>
<tr>
<td>Alt+F8</td>
<td>Switches to Master Watermark Mode</td>
<td>Shift+Home</td>
<td>Goes to first clip on the Storyboard</td>
</tr>
<tr>
<td>Alt+F9</td>
<td>Switches to Master Audio Mode</td>
<td>Shift+Page Down</td>
<td>Go to next page on the Storyboard</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Preview</td>
<td>Shift+Page Up</td>
<td>Go to previous page on the Storyboard</td>
</tr>
</tbody>
</table>

## Library

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+C</td>
<td>Show Color Boards</td>
<td>Ctrl+Tab</td>
<td>Switches between Show All Media/Video/Audio/Images/Color Boards</td>
</tr>
<tr>
<td>Alt+D</td>
<td>Detects scenes in active clip</td>
<td>Ctrl+Shift+I</td>
<td>Import Directory</td>
</tr>
<tr>
<td>Alt+Shift+C</td>
<td>New Color Board</td>
<td>Shift+Space</td>
<td>Plays clip in Video Viewer</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Import Media</td>
<td>Shift+Tab</td>
<td>Switches between Thumbnails/Details</td>
</tr>
</tbody>
</table>
# Preview Window Controls

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Bar</td>
<td>Plays/Pauses file</td>
<td>Ctrl+R</td>
<td>Record (when enabled)</td>
</tr>
<tr>
<td>S</td>
<td>Stops playing file</td>
<td>Ctrl+End</td>
<td>To end of file</td>
</tr>
<tr>
<td>Ctrl+Left arrow</td>
<td>Step Backward</td>
<td>Ctrl+Enter</td>
<td>Apply</td>
</tr>
<tr>
<td>Ctrl+Right arrow</td>
<td>Step Forward</td>
<td>Ctrl+Home</td>
<td>To start of file</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Mark In</td>
<td>Ctrl+Page Down</td>
<td>Jump forward</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Mark Out</td>
<td>Ctrl+Page Up</td>
<td>Jump backward</td>
</tr>
</tbody>
</table>

## Other

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+1</td>
<td>Add Scene (Scene Detection)</td>
<td>Ctrl+3</td>
<td>Split video (Scene Detection)</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Takes snapshot (Trim, Webcam, TV Tuner)</td>
<td>Insert</td>
<td>Add item (Titles, DV Batch Capture, Audio, Master Audio)</td>
</tr>
</tbody>
</table>
Preferences

When using PowerDirector, we give you the luxury of deciding the processes and routines of how files are applied to the Storyboard, how captured files are stored, the display of file information, previewing options and a host of others. Preferences are accessed through Edit > Preferences...

General Preferences

- The first option here is for users to select a default media Import Directory and Export Directory for all their files. Type in the directory path or click Browse and search for the directory. Click OK after you select the proper directory.
You may decide the number of recent files to be displayed under File > Recent Files in the Recently Used Files section. Click on the drop-down menu and select the number of recent files to be displayed. Click Clear List to clear all the recent files. Select Automatically load the most recent project to save time whenever you start PowerDirector.

The next selection is Capture File Name. Use the Default Name to automatically name captured media files without your input. If you want to name each captured file individually, click the Always prompt me to confirm the file name option and a dialog box will open whenever you capture a media file.

Click OK to exit Preferences.
In the **Removing Clip Preferences** section, you may specify whether or not you wish to be prompted to delete from your hard drive the files that you delete from the Library. Checking this option provides an easy way to remove unused media files from your hard drive. If you leave this option unchecked, clips are not deleted from your hard drive, but are removed automatically from the Library.

You may set the default length of image clips and video transitions in the Storyboard under the **Default Durations** section.

For the **Applying Clip Preferences** section, select one of the options. The first option automatically applies clips after previewing, while the second applies clips after you make changes to it. Leave these options unchecked if you would like PowerDirector to remind you if you would like to apply the changes that you have just made.

Click **OK** or another tab to set more preferences.
Display Preferences

The Library Files Tool Tips Display determines how all your media files’ tool tips are displayed in the Library. Check and uncheck the selections to show or hide the desired information.

The Storyboard Display is the next section. Check and uncheck to Show file name or Show duration. You may not choose both.

The Frame Rate Display option allows you to set the default number of frames per second for any movie that you produce in PowerDirector. Choose NTSC (30 fps) or PAL (25 fps).

Click OK or another tab to set more preferences.
The first section is the **Capture Destination**. Check the selections if you would like to automatically add the recently captured files to the Library, Storyboard, or both.

For **Capture Performance**, if you want your VGA card to regulate the video overlay so less CPU resources are consumed, speed is faster, but less stable than non-overlay mode in some cases (depending on your VGA card), click **Use video overlay**.

In the **Auto Scene Detection in Capture Mode** area, you can specify if you would like to perform automatic scene detection while capturing video. If you choose to detect scenes, you can select to detect by changing of video frames or to detect in real-time by changing of time codes (which is only available DV VCR mode). This latter option splits the detected scenes into individual files.
The next selection is for snapshots that you have captured from your video content in the Capture or Trim Modes.

- **Snap to Clipboard** captures the image onto your Windows’ clipboard.
- **Snap to Wallpaper (Center)** will capture the image, place the image centered on your desktop in its original size, and save it automatically in your default Windows’ System folder.
- **Snap to Wallpaper (Tile)** will capture the image, place the image on your desktop in its original size following a tile format, and save it automatically in your default Windows’ System folder.
- **Snap to File** will capture the image directly into a folder you have selected. For this selection, you may input the file name and select a file format from the drop-down box.

- Click **DV Parameters** to set up the buffer parameters for your DV camcorder.

![DV Parameter Setup](image)

- All DV camcorders’ mechanisms and the time it takes for the tape to start rolling differ in seconds. Thus, if there is no buffer time, batch capturing will begin too early. Enter the time you would like to buffer your DV tape so that batch capturing will coincide with it. The tape will begin playing during this buffer time and after it has elapsed, capturing takes place.

- When writing to tape, all DV camcorders’ mechanisms and the time it takes for the tape to start rolling differ in seconds. Setting an adequate buffer time for sending video stream to your tape eliminates these differences so that when the tape begins writing, it coincides with the beginning of the video stream feed. Click **OK**.

Click **OK** or another tab to set more preferences.
Preview Preferences

- To set the Window Size for your Preview Window, click on the drop-down menu and select.

- When you are editing clips from the Storyboard, you may decide to reserve system resources by ignoring video effects or audio tracks during previewing or in when modifying in any of the Modes. In the Previewing Clips area, simply click to select which option you want to ignore. Be sure to check out “System Requirements” on page 3.

- Whenever you click Play Movie on the Storyboard, you may wish to Play from selected clip or Play from first clip. Select one.

- During the actual production process, you may choose which type of display is utilized. The Don’t display preview selection saves the most system resources. For the Display a quick video preview, not every frame will be displayed. Check Display the full video preview in real-time if you want to watch the entire movie’s preview.

Note: There is no audio during the Production Process.

Click OK or another tab to set more preferences.
PowerDirector allows you to capture almost anything under the sun provided that you have a capture card or other assortment of adapter cards in transferring data into your hard drive. Listed below are video capture devices that may assist you in making the best possible movie out there:

- capture card (PCI, USB, FireWire or other FireWire formats)
- DV camcorder or DV VCR
- analog camcorder or VCR in 8mm, Hi8, VHS, VHS-C, Beta format
- digital camera
- PC camera

Just make sure you have all the proper hardware and drivers installed before you begin.
Capturing Video and Audio

Now you are ready to capture video or audio footage from practically anything digital or analog stored in your library and transforming it into digital footage with special effects directly authored from PowerDirector.

This section will cover video capture devices that are input through your adapter cards via video ports such as Composite video, S-Video or Tuner and also audio capture devices through ports such as Audio In or from your audio CD. However, this section won’t include capturing from a DV camcorder. Please refer to “Capturing from DV Camcorders” on page 57 for more information.

Make sure your devices are installed properly with the proper drivers. Refer to their respective user’s guide for more information.

1. Start PowerDirector. Click the **Capture Mode** located on the Modes Wheel.

2. Depending on the content you would like to capture (audio or video), click the appropriate Capture icon, either **Analog Video Capture** or **Audio Capture**.
If you clicked Analog Video Capture, click Video Setup to modify. The default tab will be Video Setup.

- Click on the Capture Device drop-down menu to select the appropriate video capture device installed on your system.
- Select the correct Capture Source. Usually, all the sources will have ports located on the capture card. Make sure the connections are secure.
- If you selected Video Tuner, you may then select either CATV (if you have a cable connected) or Antenna installed. Select a channel and click OK. To set up your TV, click on the TV Setup tab. Find your location. For non-tuner sources (e.g. S-Video or Video In sources), select the television signal format. Click OK.
If you would like to adjust your video while in the Video Setup, click the Video Adjustment tab.

Adjust Brightness, Hue, Saturation, Contrast, and Sharpness levels by dragging the sliders. Click OK when you are done.

While in the Video Capture mode, select a Profile Setup by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for Video for General Purposes, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats, refer to #4 in "Producing AVI Files".

If you selected a MPEG profile, you may create a custom MPEG profile by clicking New... Refer to "Creating Custom MPEG Profiles" on page 100 for more information. If you selected an AVI profile and want to change its settings, click Settings... and then refer to "Setting AVI Profiles" on page 110 for more information.
If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.

- After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.
- Click **OK** when you are finished with the Video Setup.

**Note:** *If the video display is blank after you have selected to capture video, be sure your video device is functioning properly. Other possibilities may be that the connections aren’t set up properly or you selected the wrong input settings.*

Now, modify the **Audio Setup** if you are capturing audio by clicking on it either in Video or Audio Capture. A dialog box will appear.

- Click on the **Audio Device** drop-down menu to select the appropriate audio capture device installed on your system.
- For the **Audio Input**, select the right input source (selections here will depend on your sound card manufacturer). Click **OK**.
- If you have an audio CD, select the **Audio CD** selection for the Audio Input and an additional drop-down menu will appear to select the audio track that you would like to capture/rip.
- You may select **Rip selected CD track at highest speed** in order to rip the selected track into your HDD into WAV format. Click **OK**.
To alter the audio capture profile, switch to the Audio Capture mode and then click **Profile Setup**. A dialog box will appear.

- Click a **Name** (i.e. profile) or change your **Attributes** by clicking on the drop-down menu and choosing another one.
- Click **Save As** to save the new profile. Name the new profile and click **OK**. To remove, select a profile and click **Remove**. After you are done, click **OK**.
- Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.
- Click the **Size Limit** box to set it and then input the maximum recording size in MB.
- If you are in the Video Capture mode, you may click **Snapshot** to capture still images from your video content. To set your preferences, go to "Capture/Export Preferences" on page 48 for more information.

3 Depending on your device, turn it on, press **Play** or activate any other function so that your external capture device will begin capturing or playing content that PowerDirector is able to record. When ready, click PowerDirector’s **Record**.

**Note:** For example, a PC camera would not have to be activated after its power is turned on, for it will begin capturing content automatically.

**Note:** An audio CD, on the other hand, does not need to be played. Just click Record and PowerDirector will begin playing and recording it.

4 Click PowerDirector’s **Stop** function after finishing your capture. The file will now be saved automatically, or appear in your Library or Storyboard. (You can also select to begin detecting scenes automatically after the capture is completed.) Go to "Capture/Export Preferences" on page 48 for more information.
Capturing from DV Camcorders

Whether your DV is playing video or filming special moments, PowerDirector captures it all in non real-time or in real-time.

**Info:** Unlike real-time capture, non real-time capture will utilize a buffer and is recommended for users who desire high quality but do not possess adequate computing power. Thus, non real-time capture will take longer to process the encoding of captured content when utilizing a buffer. A display of the time remaining for capturing will be located at the bottom right corner below the Preview Window. With real-time capture, the actual content being encoded will coincide with the content that is being played in the Preview Window and consume more CPU resources. This will not hold true for non real-time capture.

And, with the astounding FireWire transfer protocol, you will capture crystal clear digital video and audio from your DV camcorder and transfer data without any quality loss whatsoever.

Capturing from a DV camcorder differs in two respects. As you might well be aware of, DV camcorders come with two main modes. The first mode is to record live content and is referred to as the **Camera** mode for most brands. The alternative mode is the **VCR** mode (for most brands) where you may play back your previously recorded content and navigate through the DV tape. The degree of controlling your DV camcorder with PowerDirector differ in these two DV modes.

**Note:** Before starting PowerDirector, make sure all devices are installed properly with the proper drivers, your DV camcorder is turned on, is in the correct mode, and the FireWire cables are hooked up properly. Refer to the respective user’s guide for more information.
Capturing from DV Camera Mode

When your DV camcorder is in the Camera mode, PowerDirector may only Record into your hard drive, for it will simply capture what your DV camcorder is aimed at or what it is recording. For other commands in the Camera mode, you will have to rely on your DV camcorder’s controls.

1. Start PowerDirector. Click the Capture Mode located on the Modes Wheel.
2. Click the DV Capture icon. If your DV camcorder is hooked up properly along with the FireWire cables, turned on, and in the Camera mode (this will depend on your DV camcorder’s designation), a live shot from your DV camcorder should be displayed in PowerDirector’s Preview Window.

Tips: The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in the General tab under Edit > Preferences... in the Capture File Name section.

3. Now, decide if you would like to capture in Non Real-time (default) or Real-time (switch on).
4. Select a Profile Setup by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for Video for General Purposes, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose.
Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New...** Refer to "Creating Custom MPEG Profiles" on page 100 for more information. The DV AVI profiles may not be modified.

- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.
  - After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.

5. Click **OK**.

---

**Caution:** If you have selected the DV AVI profile, you will be unable to capture in non real-time.

- Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.
- Click the **Size Limit** box to set it and then input the maximum recording size in MB.

6. To begin capturing, click PowerDirector’s **Record** button.

7. Click **Stop** after finishing your capture. The file will now be automatically added to the Library or Storyboard according to your preferences. (You can also select to begin detecting scenes automatically after the capture is completed.) To set your preferences, go to "Capture/Export Preferences" on page 48.

---

**Note:** If you have chosen to capture in non real-time, after you have clicked Stop, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.
Capturing from DV VCR Mode

When your DV camcorder is in VCR mode, PowerDirector has a high degree of control. All navigational functionality may be controlled by PowerDirector including playing, seeking, pausing, stopping and of course, recording content directly from the DV tape. After capturing content from your DV tape with PowerDirector, you may apply all the special effects you wish, which have made PowerDirector a powerhouse in the arena of video editing. Finally, when it is time to produce, PowerDirector provides the luxury of writing your new movie directly onto your DV tape! Please refer to "Producing Your Movie" on page 93 for more information on producing.

1  Start PowerDirector. Click the **Capture Mode** located on the Modes Wheel.

2  Click the **DV Capture** icon. Make sure you’re DV camcorder is hooked up properly along with the FireWire cables, is turned on, and in the **VCR** mode (this will depend on your DV camcorder’s designation). The display you are viewing in PowerDirector’s Preview Window should be exactly as your DV camcorder screen.

**Tips:** The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in the General tab under Edit > Preferences... in the Capture File Name section.
3 Now, decide if you would like to capture in **Non Real-time** (switch up) or **Real-time** (switch down).

4 Select a **Profile Setup** by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for **Video for General Purposes**, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New...** Refer to "Creating Custom MPEG Profiles" on page 100 for more information. The DV AVI profiles may not be modified.

- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.

- After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.

5 Click **OK**.

---

**Caution:** If you have selected the DV AVI profile, you will be unable to capture in non real-time.

6 To seek to the proper time, drag and release the **Shuttle** icon. Located to its immediate left is the timecode area for the DV tape.

---

**Note:** If the DV tape’s timecode is incorrect, then click **Seek Tape** to verify the timecode.

- You may also navigate with the **Play**, **Next** and **Previous Frame**, **Start**, **End**, **Pause**, and **Stop** buttons. Refer to #2 in "Previewing your Library Files" on page 32 for more information on the aforementioned commands.

- Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.
Click the **Size Limit** box to set it and then input the maximum recording size in MB.

7 To begin real-time capture, click **Play** on your camcorder and then click PowerDirector’s **Record** button when you’re ready. The total recording time will be displayed above the DV tape’s timecode area.

**Note:** When capturing in non real-time, if your HDD is almost out of space (if less than 150 MB of free space, all capturing will be disabled), a warning message will appear in the Preview Window notifying that a portion of the transcoding process will be paused and resume later only after all the content in the buffer has been encoded by your HDD.

8 Click **Stop** after finishing your capture. The captured file may appear directly in your Library or Storyboard depending on preferences. (You can also select to begin detecting scenes automatically after the capture is completed.) Go to "Capture/Export Preferences" on page 48 for more information.

**Note:** If you have chosen to capture in non real-time, after you have clicked Stop, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.
Batch Capturing from DV Camcorders

When you are in the DV VCR mode, you may select precise scenes you want to convert. After selecting a few scenes, you may convert them with one click as part of a whole batch of files. Batch capturing is efficient and saves huge amounts of time when capturing numerous scenes.

Tips: Be sure that your DV tape’s timecodes are linear. If not, you might have to capture a scene at a time in the DV VCR mode.

1. Start PowerDirector. Click the Capture Mode located on the Modes Wheel.
2. Click the DV Capture icon. Make sure your DV camcorder is hooked up properly along with the FireWire cables, is turned on, and in the VCR mode (this will depend on your DV camcorder’s designation). The display you are viewing in PowerDirector’s Preview Window should be exactly identical to your DV camcorder screen.
3. Click Batch Capturing.

Tips: The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in the General tab under Edit > Preferences... in the Capture File Name section.
Now, decide if you would like to capture in **Non Real-time** (default) or **Real-time** (switch on).

Select a **Profile Setup** by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for **Video for General Purposes**, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New...** Refer to "Creating Custom MPEG Profiles" on page 100 for more information. The DV AVI profiles may not be modified.

- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.
  
  - After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.

6 Click **OK**.

**Caution:** If have selected the DV AVI profile, you will be unable to capture in non real-time.

- To shuttle (fast forward/rewind) to the proper time, drag and release the **Shuttle** icon.

- Click **Seek Tape** to locate the exact timecode position of the DV tape.
Capturing Content

**Note:** Depending on the specific DV tape, there may be identical timecodes for many different scenes on a DV tape (e.g. 00:01:20). This is attributed to the resetting of timecodes performed by the author. When seeking tape with PowerDirector, it will only seek to the first timecode. If your DV tape has been reset numerous times, it is advised for you to capture in DV VCR mode, for capturing in batch mode highly relies on linear timecodes.

You may also navigate with the **Play**, **Next** and **Previous Frame**, **Rewind**, **Fast Forward**, **Pause**, and **Stop** functions of PowerDirector. Refer to "Previewing your Library Files" on page 32 or use your DV camcorder’s navigational buttons.

7 To begin adding tasks, go to the correct time position where you would like to begin batch capturing and click the **Add New Task** icon. A new batch task will appear in the batch box.

```
<table>
<thead>
<tr>
<th>Start Time</th>
<th>Stop Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:25:23</td>
<td>00:00:33:07</td>
</tr>
<tr>
<td>00:02:01:05</td>
<td>00:02:27:22</td>
</tr>
</tbody>
</table>
```

**Note:** The Mark Out position ("Stop Time") will automatically be set 5 seconds ahead of the Mark In position ("Start Time"). Be sure to set the correct Mark Out position.

8 Navigate to the end of the segment you would like to convert and click **Mark Out**.

- To reset the Start Time, navigate to the beginning of the segment and click **Mark In**.

9 To begin conversion, be sure the specific task(s) is checked first. Click **Start Selected Task(s)** to begin capturing your batch.

**Note:** When capturing in non real-time, if your HDD is almost out of space (if less than 150 MB of free space, all capturing will be disabled), a warning message will appear in the Preview Window notifying that a portion of the transcoding process will be paused and resume later only after all the content in the buffer has been encoded by your HDD.
10 Click Stop to abort batch capturing.

**Note:** If you have chosen to capture in non real-time, after you have clicked Stop, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.

- Repeat the above steps to add more tasks.
- To remove tasks, select one and click Remove Task.

After it is completed, the batch captured files may appear directly in your Library or Storyboard depending on preferences. (You can also select to begin detecting scenes automatically after the capture is completed.) Go to "Capture/Export Preferences" on page 48 for more information.
CHAPTER 5:
TRIMMING VIDEO

Trim Mode

Generally, after your media files are imported into your library, the next step is to trim your video clips or set the time limit for image files. Before production, this step is very important in eliminating unwanted portions of your video clip and to place more focus on the essential plot of your movie.

**Note:** After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

**Note:** Your original media files will not be manipulated in any way when trimming files that have been imported into the Library or after it is applied to the Storyboard.

1. Select a media file and click the Trim Mode located on the Modes Wheel.
Note: Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to “Edit Preferences” on page 46 for more information.

2 Before setting your trim positions, you may play your file. Go to “Previewing your Library Files” on page 32 for more information on navigation during playback.

   - Drag and release the Time Slider \(\uparrow\) to find the exact time positions and quicken your search. You may also Play, Rewind, Fast Forward, Pause, jump to the Start or End of the file, and go to the Next or Previous Frame.

   - To capture the frame as a new image file, click Snapshot \(\square\). Go to "Capture/Export Preferences" on page 48 for more information.

3 Click on the Mark In \(\square\) and Mark Out \(\square\) icons to set your trimming positions at the Time Slider \(\uparrow\) position or set them during playback. Or, you may also utilize the Time Slider and directly drag the Mark In \(\downarrow\) and Mark Out \(\uparrow\) sliders to the position where you would like to begin your trim.

   - Both trim position borders can be dragged on the Time Slider bar. Use this feature to quickly change the Mark In and Mark Out positions.

   - After your Mark In and Mark Out positions have been set, their times will be displayed to the right of each respective icon along with the time length for this new clip in the bottom right area. The other time slot on the bottom left indicates the current position of the Time Slider.

Note: Durations are displayed as HH:MM:SS:FF (i.e. hours:minutes:seconds:frames).

   - To Resize your view, select one of the options from the drop-down menu. (A sample thumbnail of each option appears under the drop-down menu, providing an instant preview of each option. The effect is likewise applied to your file in the Preview Window.)
- **Stretch**: This option will stretch your media file to fill out the screen but will not keep the aspect ratio.

- **Letterbox**: This option will fit your media file into the Preview Window but (unlike Fit to output size) will keep the aspect ratio of the media file and won’t crop the image.

- **Crop**: This option will fill out the Preview Window with the original size but will crop the image.

**Note:** The Resize function will not alter your original file but will affect your Storyboard clip.

- Click **Revert** to return to the original trim (if the clip had already been trimmed) or click **Clear** to start from scratch.

4. When you are satisfied with your trim, click **Apply** and your trim will be applied to your Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.

### Splitting the Video File

To save precious editing time, the Split Video function automatically splits an original video file into two separate clips with one swift click and eliminates the need to drag the same file onto the Storyboard twice and trimming both separately. Just keep in mind this function is only intended for Library files that do not have effects applied from other modes. Apply effects only after you split the video.

1. Select a media file from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2. To split video files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

**Note:** If the Storyboard clip has been previously modified or contain effects, this clip may not be split.

3. Click the **Trim Mode** located on the Modes Wheel.

4. Drag the **Time Slider** to the scene where you would like to split this video or through any other navigational method.

5. Click **Split Video**. The file will be split into two clips on the Storyboard.

- If you would like to further trim either clip, refer to "Trim Mode" on page 67.
Trim Mode for Image Files

Naturally, image files don’t need to be trimmed. The time duration of the appearance of the image file may be set along with the image’s resize if desired.

1. Once your image files have been imported into the Library, double-click on an image file or drag it in order to display it in the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2. To modify files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3. Click on the Trim Mode 🔄 from the Modes Wheel.

   - To Resize, select one of the options from the drop-down menu.
     - **Stretch**: This option will stretch your media file to fill out the screen but will not keep the aspect ratio.
     - **Letterbox**: This option will fit your media file into the Preview Window but (unlike Fit to output size) will keep the aspect ratio of the media file and won’t crop the image.
     - **Crop**: This option will fill out the Preview Window with the original size but will crop the image.

   - Enter the time for the image to appear in the Duration box by using the arrows or inputting a numeral.
   - Click Revert 🔄 to revert to the original trim.
   - Or click Clear ✗ to start over.

4. Click Apply when complete. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
Altering Speeds

To invigorate your audience and enliven your movies with a different pace or tempo, or to emphasize certain elements of meaningful clips, PowerDirector allows you to go slo-mo or accelerate clips to previously unforeseen speeds! Any clip could be slowed down to a crawl or sped up to the speed of light. As a director, utilize both these mind-altering speed effects to throw your audience for a loop, because as any sane person or scientist will protest to, time is relative to the observer except in the warped parallel universe of PowerDirector.

1. Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2. To add effects to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3. Click Speed Mode on the Modes Wheel.

4. Drag the slider in order to slow or quicken up the video speed. You may also click Increase Speed or Decrease Speed with the range being 1/4X - 8X.
Now, you must decide how your video file’s audio will be played. Click on the **Audio Setting** drop-down menu and select one.

- The **Synchronize with video** selection will synchronize the video speed with the audio speed.

**Note:** If the video speed is faster or slower than 1X, the synchronized audio may be unrecognizable.

- Select **Preserve original speed** if you prefer the audio speed to be at its original recognizable speed independent of the video speed.
- Select **Mute** to mute this video file’s audio. This is great for dubbing over original audio content with another audio file or background music.
- Click **Revert** to return to the previous state or click **Clear** to start from scratch.

After you are satisfied with your alteration, click **Apply** to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
Supplying Video Effects

Supplying video effects is for the music video director in you! For normal movies, transition effects are sufficient, but for those who wish to cast a spell and enrapture the audience with a video effect that takes hold throughout the length of one clip, this is your epiphuous calling.

Let’s first enjoy a graphical display of all the effects:
Below is a table that summarizes the settings available for each video effect.

<table>
<thead>
<tr>
<th>Video Effects</th>
<th>Settings Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Brightness, Contrast, Hue, Saturation, Sharpness</td>
</tr>
<tr>
<td>Blur</td>
<td>Degree</td>
</tr>
<tr>
<td>Color Focus</td>
<td>Depth of Gradient Border, Width of Color Area, Height of Color Area</td>
</tr>
<tr>
<td>Delay</td>
<td>Regularity</td>
</tr>
<tr>
<td>Edge</td>
<td>Degree, Background Color, Foreground Color</td>
</tr>
<tr>
<td>Emboss</td>
<td>Direction</td>
</tr>
<tr>
<td>Focus</td>
<td>Depth of Gradient Border, Width of Original Image, Height Information Display</td>
</tr>
<tr>
<td>Grid</td>
<td>Depth of Grid Line, Width, Height, Background Color</td>
</tr>
<tr>
<td>Mosaic</td>
<td>Width of Blocks, Height of Blocks, Effect Length</td>
</tr>
<tr>
<td>Noise</td>
<td>Intensity, Size, Background Color</td>
</tr>
<tr>
<td>Ripple</td>
<td>Wave Length, Speed, Effect Length</td>
</tr>
<tr>
<td>Skip</td>
<td>Frequency</td>
</tr>
<tr>
<td>Spotlight</td>
<td>Brightness, Depth of Gradient Border, Width, Height, Information Display Background Color</td>
</tr>
<tr>
<td>Swing Left</td>
<td>Angle, Background Color, Effect Length</td>
</tr>
<tr>
<td>Swing Down</td>
<td>Angle, Background Color, Effect Length</td>
</tr>
<tr>
<td>Swing Right</td>
<td>Angle, Background Color, Effect Length</td>
</tr>
<tr>
<td>Swing Up</td>
<td>Angle, Background Color, Effect Length</td>
</tr>
<tr>
<td>TV Wall</td>
<td>Horizontal Number, Vertical Number, Effect Length</td>
</tr>
<tr>
<td>X-Ray</td>
<td>Degree</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Size, Effect Length</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Width, Height, Background Color, Effect Length</td>
</tr>
</tbody>
</table>
1 Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2 To add effects to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click Effects Mode on the Modes Wheel.

4 Drag an effect from the Library over to the Preview Window or double-click the effect. Depending on the effect, settings will vary.
For most effects settings, simply drag the slider and then preview it in the Preview Window before applying. Refer to "Previewing your Library Files" on page 32 for more information.

For some effects settings, you can set the duration of the effect by clicking and dragging the Mark In and Mark Out sliders to a new position. You can also position the Time Slider and then click Mark In or Mark Out at the new Time Slider location. You can drag any of the four Mark In, Mark Out, and Hold Time borders to quickly change their positions on the Time Slider bar.

The entire video effect setting (including the Mark In and Mark Out times and the Hold Time) can likewise be dragged on the Time Slider bar. Use this feature to quickly change the point in the video clip at which the video effect appears and disappears.

For some effects settings, you will notice a Link Settings function that links two given settings and constrains the proportion of a video effect such as for the Grid and TV Wall effects. To unlink these settings, click on it.

For some effects settings, you may choose a Foreground Color or Background Color. Click on either and then select the color. Click OK.

Click Revert to return to the previous state or click Clear to start from scratch.

After you are satisfied with your effects, click Apply to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
CHAPTER 7: ADDING TITLES AND TRANSITIONS

Titles Mode

Generally, at the beginning of every movie or show, text is involved to convey the title, starring and supporting actors, and other information for all those involved and whom made the movie possible. When a movie or show wraps up, the full spate of credits will be rolled out too.

For smaller movie productions, you may want to inform viewers with textual effects instead of just visual effects. So, get ready to begin communicating literally like you never have before.

Note: After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1 Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2 To add titles to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click Titles Mode  on the Modes Wheel.

Note: Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to "Edit Preferences" on page 46 for more information.
Click on the **Add Title** icon. A cursor will appear in the Preview Widow for you to begin typing. Press <Enter> to skip to the next line if you wish.

After inputting your text, click outside of the box. The title will be displayed in the Titles box along with the Preview Window.

- To edit the text you have entered, double-click on the title in the Preview Widow. A cursor appears inside the text, allowing you to edit it.
- Click the **Fonts** icon to set your font format. There are a host of options here including Spacing, Color, Font Style, and Alignment. After you are finished, click **OK**.
To select a suitable **Title Effect**, select a title first and then click on the effect thumbnail in the Library to select. An instant preview will be shown in the Preview Window.

Drag the **Hold Time** slider to determine the length of static time for the effect. You can also set the duration of the effect (in seconds) by using the up and down arrows or by entering a value up to two decimal places using your keyboard. By increasing the Hold Time (represented by the blue bar), the static time for your title’s effect (i.e. only the text without effects) will be increased and vice-versa.

**Note:** Each chosen title effect vary in terms of duration length.

To minimize the duration of an entire title effect (i.e. you don’t want the title effect to last the entire duration of the clip), click and drag the **Mark In** and **Mark Out** sliders to the desired position. Or, position the **Time Slider** at a designated point and then click **Mark In** or **Mark Out** below the Preview Window. You can also drag any of the four Mark In, Mark Out, and Hold Time borders to quickly change their positions on the Time Slider bar. Use this feature to quickly change the duration of the effect as well as when the effect appears and vanishes.

The entire title effect setting (including the Mark In and Mark Out times and the Hold Time) can likewise be dragged on the Time Slider bar. Use this feature to quickly change the point in the video clip at which the title effect appears and disappears.
To place a title at a certain area of the screen, simply click on it in the Preview Window and drag.

- Click **TV Safe Zone** to display a dashed outline around the inside of the Preview Window. This zone represents the area in which content is sure to be displayed on TV screens, which have a smaller display area than computer monitors. (The TV Safe Zone outline will not appear when your movie is previewed or produced.)

- Click the **Grid Line** to display a grid of dashed lines that can aid in positioning your text more precisely. (Grid lines will not appear when your movie is previewed or produced.)

- Click **Revert** to return to the original titles and their associated effects or click **Clear** to start from scratch.

- Repeat the above steps to add more titles.

- To edit or remove titles, click on a title in the Titles box. To edit, click twice and a cursor will appear in the box. Begin editing.

- To remove, select an existing title and then click **Remove Title**.

- You may hide titles by unchecking **Show All Titles** or checking to show all.

After you are satisfied with all your titles, click **Apply** to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
Transitions Mode

Usually invisible to the naked eye, transitions are a great mood enhancer in movies or full-length feature shows and videos. Generally, scene-from-scene, simple fades or a direct cut to the next scene is used. To further enhance your video, you may want to try one of the many transitional effects PowerDirector has provided.

Before you begin, be sure that there are at least two video clips or images that have been applied in the Storyboard.

**Note:** After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1. Click a transition icon located anywhere between two clips from the Storyboard.

2. Or, you may select a clip from the Storyboard and then click **Transitions Mode** on the Modes Wheel.

**Note:** Transitions may not be applied to the last clip on the Storyboard.

- To preview a transitional effect before you apply, place your cursor above a given transition in the Library.

3. Select a transition by clicking on it or dragging to the appropriate point between the selected clip and the clip immediately proceeding it on the Storyboard. You may also drag the transition from the Library to the Modes Panel. The chosen transition will now appear in the Modes Panel.
4 Input the **Transition Length** located in the Modes Panel numerically or drag the slider to increase and decrease. The length will vary depending on your clips’ duration.

![Transition Length](image)

**Note:** Keep in mind that the length you set will be equally divided amongst the two slides. If you set ten seconds, five seconds of the transitional effect will be allotted to the end of the first media file while five seconds will be allotted to the beginning of the succeeding media file.

**Tips:** Don’t forget that many of the transitional effects are so radical, that they will literally “swallow” up some of your clip’s content. Consequently, be sure that your clips have ample time in the beginning and in the end so as not to interfere with your clip’s content and that the transition length is not set too long.

- Click **Revert** to revert to the original transition effect or click **Clear** to clear all transitions.

5 When you are finished with your selection, click **Apply** to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.

- Right-click on any transition for a shortcut menu that provides an efficient way to manage the transition effects in the Storyboard. Select one of the options to **Cut, Copy, Paste, Remove, Apply to All, or Clear All Transitions.**
CHAPTER 8: ADDING AUDIO AND PICTURES

Audio Mode

As all amateur or seasoned video professionals know, the soundtrack of your movie is incredibly important to set the mood and atmosphere of your movie. For exciting scenes, a musical score with a fast beat will serve to outline the hastiness and recklessness of the occasion. For tender moments, a beautifully scored song touching on romance and playing with your emotions like a concert violinist will go a long way in making your post-production a worthy undertaking.

Note: After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1 Select a file from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 30 for more information on importing.

2 To add audio to clips that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click Audio Mode on the Modes Wheel.

Note: Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to "Edit Preferences" on page 46 for more information.
If your original file or clip contains audio, it will be displayed in the uppermost line. Three user-defined audio files are allowed, which will be displayed below the original file. All of these files can be independently manipulated by clicking them and changing their individual settings.

To add more audio files to a certain clip, drag them from the Library into the User-Defined box or onto the Preview Window, or you may click the Add Audio icon, which opens a browser window. A flashing message will appear in the Preview Window to show you where you should drag the audio file to. (This message disappears after the first audio file is added.)

When all three tracks in the User-Defined box are full, you can no longer add new audio files. Click the Remove Audio icon to remove a file, then add another audio file.

To trim the audio, select a particular file and click Trim Audio.

Note: You are not allowed to trim the audio portion of the original video file.
7  Trimming controls are very similar to trimming other media files. Please refer to #3 in "Trim Mode" on page 67 for more information. Click **Apply** and then **OK** when you are finished trimming your audio clip.

- If you would like to repeat any of the audio files that appear under the User-Defined heading, click the file to select it, then drag the Time Slider in the Preview Window to the point at which you would like the file to end. The audio track will repeat from the start of the video file to the point you set.
  - The entire audio setting (including the Mark In and Mark Out times) can likewise be dragged on the Time Slider bar. Use this feature to quickly change the point in the video clip at which the audio file starts and stops playing.

- If you want the audio clip to **Fade In** or **Fade Out**, click the corresponding option and set the duration of the fade (in seconds) by using the up and down arrows or by entering a value up to two decimal places using your keyboard.

- Adjust the volume by dragging on the **Volume Mixing** to increase or decrease after you have selected the audio file. Drag to the farthest left to mute it. Keep in mind that this volume will be combined with the original clip’s audio volume (if applicable).

- Click **Revert** to return to the original clip’s audio effects (if the clip had employed audio clips previously) or click **Clear** to start from scratch.

8  Click **Apply** when you are finished to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.

---

**Note:**  If two adjacent image or video files in the Storyboard contain audio clips, the audio portions of these files will cross fade to allow for a smoother transition.
Chapter 8

Master Audio

To further accentuate the audio aspect of your movie production, you may wish to apply a musical score that will act as the background audio for your entire movie. The controls and options for the master audio file is very similar to the normal Audio Mode where you add files to various clips.

Caution: If you utilize Master Audio in your movie, SVRT will be disabled when producing.

1. Click Master Audio located on the Storyboard’s farthest left.

2. The Master Audio controls will be displayed below the Modes Wheel in the Modes Panel. Drag an audio file from the Library into the Preview Window, or you may click the Add Audio icon, which opens a browser window. A flashing message will appear in the Preview Window to show you where you should drag the audio file to.
Note: If you already have an audio file in Master Audio, a dialog box will appear to ask you in replacing your original file after you have dragged the new file to the Preview Window. Click OK.

3 Click Trim Audio (cke) to begin trimming your Master Audio file. Trimming controls are very similar to trimming other media files. Please refer to #3 in Trim Mode for more information. Click Apply and then OK when you are finished trimming your audio clip.

- If you want the audio clip to Fade In or Fade Out, click the corresponding option and set the duration of the fade (in seconds) by using the up and down arrows or by entering a value using your keyboard.

- Adjust the volume by dragging on the Volume Mixing to increase or decrease after you have selected the audio file. You may adjust the volume from 0-200% of the original level.

- To Repeat Master Audio, click to check the box so that it will repeat until the end of the entire movie.

- Click Revert (c3) to return to the original Master Audio file or click Clear (x3) to start from scratch.

4 You do not need to click Apply in this mode. Just switch out of the mode and your Master Audio will be set and save your project.
Chapter 8

Picture-in-Picture Mode

For any of your existing video clips or image clips on the Storyboard, you may add a still image or video to the background. Set the transparency level depending on your preferences.

**Note:** After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1. First, select the default picture or video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. The file will be displayed. Refer to "Importing into the Library" on page 30 for more information on importing.

2. Or, you may select a clip that has already been applied to the Storyboard by simply selecting the particular clip and it will be displayed in the Preview Window.

3. Click the Picture-in-Picture (PiP) Mode located on the Modes Wheel.

**Note:** Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to “Preferences” on page 44 for more information.

4. A message will flash in the Preview Window. Select the second “picture” from the Library in the form of an image, video file, or scene detected from a video file by dragging it there.
Adding Audio and Pictures

Note: If you already have a PiP file applied to the original clip, a dialog box will appear to ask you in replacing your original file after you have dragged the new file to the Preview Window. Click OK.

- Click and drag the points located on the edge of the file to enlarge or decrease its size. Keep in mind that the Keep Aspect Ratio is checked as the default. If you do not want to retain its width-to-length size ratio intact, uncheck it.

![PiP window](image)

- Click the TV Safe Zone toggle button to display a dashed outline around the inside of the Preview Window. This zone represents the area in which content is sure to be displayed on TV screens, which have a smaller display area than computer monitors. (The TV Safe Zone outline will not appear when your movie is previewed or produced.)

- Click the Grid Lines toggle button to display a grid of lines that can aid in positioning the second picture more precisely. (Grid lines will not appear when your movie is previewed or produced.)

- To Apply Color Filter, go to "Applying Image Color Filters" on page 92 for more information.

- Drag the Transparency slider to make the picture more or less transparent.

- Click Revert to return to the original clip’s PiP file and its associated modifications or click Clear or press <Delete> on your keyboard to start from scratch.
5 To minimize the duration of the second picture (i.e. you don’t want the second picture to last the entire duration of the clip), if it is an image file, go to #3 under "Trim Mode" on page 67 and follow the same directions as for trimming video files. If your second picture is a video file, click **Trim Video** , and go to "Trim Mode" on page 67.

- The entire PiP effect setting (including the Mark In and Mark Out times) can be dragged on the Time Slider bar. Use this feature to quickly change the point in the video clip at which the PiP effect appears and disappears.

6 Click **Apply** when you are finished to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
Master Watermark

There are times when you wish to add an image that will serve as a visual background throughout the movie, which will usually represent the party that has created the movie or owns the rights to it. This is a watermark. It may also be a TV station logo or the movie title.

Caution: If you utilize Master Watermark in your movie, SVRT will be disabled when producing.

1. Click Master Watermark located on the Storyboard’s left side.

2. The steps here are extremely similar to the PiP Mode except that only an image file may be used. Go to #4 in "Picture-in-Picture Mode" on page 88 for the rest of the steps.

3. You do not need to click Apply in this mode. Just switch out of the mode and your Master Watermark will be set and save your project.

To Apply Color Filter, go to "Applying Image Color Filters" on page 92 for more information.
Applying Image Color Filters

You may want to apply a color filter so that a specific color of the image file will blend the background of the image with the foreground of the original file. This option is available in the Picture-in-Picture and Master Watermark Modes.

1. With the file selected in the PiP Mode, click **Eyedropper** to apply the color filter.

2. A dialog box will appear. Now, position the **Eyedropper** tool over the color you want to filter out and then click once to select it. The color box on top displays the current color the Eyedropper is positioned over. The lower box displays the color that was last filtered.

3. Click **OK**.

4. Now, check **Apply Color Filter** by clicking in the box. To disable this function, uncheck by clicking it again.

   - Drag the **Tolerance Level** slider to extend the range of colors from the one you have selected for the Color Filter option.

5. Click **Apply** when you are finished. Be sure to set your preferences for applying to the Storyboard. Go to "Edit Preferences" on page 46 for more information.
CHAPTER 9: PRODUCING YOUR MOVIE

The time has finally arrived for you to produce your own movie. After all your hard work of importing media files into your Library, previewing them, manipulating them, and applying them to the Storyboard, the production of your grand masterpiece is imminent. This chapter will cover MPEG-1, MPEG-2, Windows Media and AVI formatted video types.

Editing and producing MPEG and DV AVI files and clips is what makes PowerDirector a powerhouse in video editing software applications.

Info: MPEG is an acronym short for the Moving Picture Experts Group which belongs to the family of ISO/IEC standards (International Organization for Standardization and International Electrotechnical Commission). It is a compression technology for digital video and audio signals intended for consumer distribution. Please refer to "What Is MPEG?" on page 141 for more information.

Many video editing software applications waste valuable time when decompressing MPEG and DV AVI files into uncompressed AVI format before the editing process. During editing, this process places unnecessary burden on your hard disk by requiring a huge amount of disk space when working with uncompressed AVI format. After it’s all said and done, when you are ready to produce into MPEG or DV AVI format, valuable time is wasted again in compressing your movie!

Not so with PowerDirector’s proprietary technology, SVRT (Smart Video Rendering Technology). If your files are originally in MPEG or DV AVI format, editing will be in the same format and when producing, invaluable time and hard disk space is preciously saved when only the edited video portions need to be rendered. This is “smart video rendering”.

93
Producing General MPEG-1 Files

As mentioned in the previous section, MPEG is the standard format this generation for compressed multimedia files with high quality. After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed MPEG format, you are ready for the final stage of your post-production process. Refer to "What Is MPEG?" on page 141 for more information.

1. Clips should be applied to the Storyboard.
2. Click **Produce Movie** located on the Modes Wheel.
3. Select **MPEG-1** from the Video for General Purposes drop-down menu. Click **Next**.
4 We recommend that you select the default **Smart Video Rendering Technology (SVRT)** selection to save time. Refer to "Glossary" on page 145 for more information on this selection’s properties.

![Smart Video Rendering Technology](image)

**Note:** If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any MPEG files. SVRT is used optimally with MPEG formatted files.

5 If you are an advanced user, you may click the second selection **MPEG-1 Video (Constant Bitrate)**.

- If you picked the second selection, click on the left drop-down menu and choose the group of profiles you want to display, which will include Default, Custom, or All.

6 After selecting a group, select the specific profile. Profile properties will be displayed immediately below the chosen profile including the recommended processing speeds of your system. If you want better resolution or quality but at the expense of hard disk consumed, choose the higher quality or higher bitrate profiles.

**Tips:** If you will be making your own VCDs (burning at a later time), choose a VCD profile. For more information on television standards such as NTSC and PAL, refer to "NTSC and PAL" on page 142.
Click **Details** for more specific information concerning a profile.

To create your own profile, go to "Creating Custom MPEG Profiles" on page 100.

7. Click **Next**.

8. For the last step, choose a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

If you would like to view your movie as soon as the production process is complete, click **Preview movie after production**. After your movie is produced, it will appear in a preview window with standard play controls, giving you full playback options.

9. Check your File Details. Click **Finish**.

During the production, there are viewing options you may set. Go to "Preview Preferences" on page 50 for more information. You may also click **Abort** during production.

Save your project if you haven’t already by choosing **File > Save Project**. Enter the file name and click **Save**.
Producing General MPEG-2 Files

As mentioned in the previous section, MPEG is the standard format this generation for compressed multimedia files with high quality. After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed MPEG format, you are ready for the final stage of your post-production process. Refer to "What Is MPEG?" on page 141 for more information.

1  Clips should be applied to the Storyboard.
2  Click Produce Movie located on the Modes Wheel.
3  Select MPEG-2 from the Video for General Purposes drop-down menu. Click Next.

We recommend that you select the default SVRT selection to save time. Refer to "Glossary" on page 145 for more information on this selection’s properties.

**Note:** If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any MPEG files. SVRT is used optimally with MPEG formatted files.
5 If you are an advanced user, you may click the second selection **MPEG-2 Video (Constant Bitrate)**.

- If you picked the second selection, click on the left drop-down menu and choose the group of profiles you want to display, which will include Default, Custom, or All.

6 After selecting a group, select the specific profile. Profile properties will be displayed immediately below the chosen profile including the recommended processing speeds of your system. If you want better resolution or quality but at the expense of hard disk consumed, choose the higher quality or higher bitrate profiles.

**Note:** If you will be making your own DVDs (burning at a later time), choose a DVD profile.

- Click **Details** for more specific information concerning a profile.
To create your own profile, go to "Creating Custom MPEG Profiles" on page 100.

7 Click Next.

If you would like to view your movie as soon as the production process is complete, click Preview movie after production. After your movie is produced, it will appear in a preview window with standard play controls, giving you full playback options.

8 For the last step, choose a file name or click Browse to look for the correct directory. After finding the directory and typing in the new file name, click Save.

9 Check your File Details. Click Finish.

- During the production, there are viewing options you may set. Go to "Preview Preferences" on page 50 for more information. You may also click Abort during production.

- Save your project if you haven’t already by choosing File > Save Project. Enter the file name and click Save.
Creating Custom MPEG Profiles

1. Either if you were in the Producing Movie process after you have chosen MPEG as your video type and selected MPEG-1/2 Video (Constant Bitrate), or in the Capture Mode and in the process of selecting a profile, to create a custom profile you must first select an existing MPEG profile that is closely associated with your new profile.

2. Then, click New... in order to create a new MPEG profile. A dialog box appears.

3. Type in a profile name and edit the description. For information on the Profile Properties, refer to "Glossary" on page 145 for more information.

4. Click on the Video tab.
   - Select a Video Size by clicking on the drop-down menu.

5. Drag the slider to set your Video Compression Rate. The higher the kbps, the less the compression with better quality, but more disk space will be consumed.

6. Some Advanced Settings may be checked as default depending on the profile you are copying from:
   - **Smoothing**: Check for a smoother image if you find video content is too fine and on the grainy side.
   - **Noise Removal**: This removes video artifacts such as white noise from video signals.
   - **Deinterlacing**: Combines two interlaced fields into a single frame and render them at 30 frames per second (fps). Deinterlacing is done to remove artifacts and improve the quality of encoded video.

7. Drag the Speed Quality Indicator to the left for higher speed but which will sacrifice quality or to the right for better quality but at a slower speed.
8 Click on the **Audio** tab.

9 The default MPEG Audio Compression setting will be Layer II stereo. For the **Audio Compression Rate**, like its Video counterpart, the higher the kbps, the less the compression with better quality, but more disk space will be consumed.

10 Click **OK** to return to the production/capture process.

- To select your new profile, select **Custom** from the profile group menu and then select the profile.
- To edit existing profiles, select the right custom profile and click **Edit**. Click **Delete** after you have selected the custom profile you wish to delete.
Producing Windows Media Files

Streaming technology has grown by leaps and bounds since its increasing usage from the last decade by providing a medium that is controlled by the content provider and therefore is free of copyright issues. And it’s only getting started.

Info: Streaming utilizes video scaling, compression techniques, and network protocols in order to transmit files from a Web server (where the streaming file is stored) to the client (your hard drive). The concept of streaming is relatively easy: the file is broken up into data packets, compressed, and sent over the Internet in a stream, or a series of related packets, along with the audio data if applicable. The client must have a player in order to decompress the packets, display the video data, and send audio data to the speakers via the sound card. The player will first buffer the packets, meaning the packets are downloaded and stored in a buffer before playback begins. This ensures smooth playback in case of breaks or interference due to unstable Internet connections. Thus, the client and its player does not have to wait for the entire file to download in order to begin playing the individual data packets.

Windows Media is a proprietary streaming audio/video format typically used to download and play files or to stream content. It is the main streaming format used for Microsoft’s Windows Media Player.

The Windows Media profiles are best for streaming content across bandwidths where you, the presenter, would like as many flexible selections as possible. Profiles range from the more basic Internet connection speeds to full-fledged broadband, audio only, and profiles containing single to multiple video streams.

After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed streaming Windows Media format, you are ready for the final stage of your post-production process.

1 Click **Produce Movie** located on the Modes Wheel.
2 Select **Windows Media** from the Video for General Purposes drop-down menu and click **Next**.

3 Now select a profile depending on what type of connection speed you will be utilizing when streaming your file to your audience. Click on the drop-down menu and select a profile. Profile descriptions and properties will be displayed immediately below the chosen profile. Refer to “Glossary” on page 145 for more details. Click **Next**.
4 For the last step, choose a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

5 Check your File Details. Click **Finish**.

6 Save your project if you haven’t already by choosing **File > Save Project**. Enter the file name and click **Save**.
Producing AVI Files

PowerDirector has the robust feature of writing directly to your DV tape in AVI format when producing. This will include all your manipulation, modifications and special effects and is just another way of making your production more mobile and timeless. You may also produce in uncompressed AVI format to your hard drive.

1. Click **Produce Movie** located on the Modes Wheel.

2. Select AVI from the Video for General Purposes drop-down menu and click **Next**.
3 We recommend that you select the default **SVRT** selection to save precious time and render like never before!

![Image of SVRT selection window]

**Note:** If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any DV AVI files. SVRT is used optimally with DV AVI formatted files.

4 For the **Profile** field, click on the left drop-down menu to display the profile group. The DV group consists of DV format profiles while the **Windows** group is the uncompressed AVI format that will take up a large amount of hard disk but is used for editing by some video editing software applications and also writing to VHS tapes or for TV broadcast.

- For information on television standards such as NTSC and PAL, refer to "NTSC and PAL" on page 142.

5 After selecting the profile group, select the specific profile with the right drop-down menu. Profile properties will be displayed immediately below the chosen profile. Click **Details** for more information on a specific profile. Click **Next**.

- To adjust and modify a Windows AVI profile, go to "Setting AVI Profiles" on page 110.

- If your FireWire connection is ready, your DV camcorder is on, and your DV tape is in place, check **Write to DV Tape** to directly write your entire production onto your camcorder’s tape. Click **Next**.

**Note:** The Write to DV Tape step will appear after your production is complete.
6  For the last step, enter a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

7  Check your File Details. Click **Finish**.

- If you decided to Write to DV Tape, after your movie is produced (hard disk version), the Write to DV Tape dialog box will be displayed. (See "Writing to DV Tape" on page 108.) Click **Show Preview** to preview when writing and then click **Start**. Click **Close** after it is complete.

8  Save your project if you haven’t already by choosing **File > Save Project**. Enter the file name and click **Save**.
Writing to DV Tape

For the Write to DV Tape function, a quick and easy way is to select a DV AVI file directly from the Library and then choose File > Export > Write to DV Tape for instant writing. You may also choose this option when you are producing AVI movies. A dialog box appears.

1 You can preview your DV tape using the play controls, or shuttle forward and backward to find the exact location where you want to write the new files to tape.
   - The files you have set to write to tape appear in the upper left corner of the dialog box.

2 To add a file, click the Add icon, which opens a browser window. To remove a file, select the file and click the Remove icon.

Note: You are only allowed to write .AVI files to DV tape.
To change the order in which the files will be written to tape, select a file and click the **Up** or **Down** arrows.

The Total Files and Total Duration that you have selected to write to tape appear in the lower left of the dialog box.

A smaller preview window in the lower left corner allows you to preview the files that you have selected to write to tape in the exact order you have selected.

3. After you are satisfied with the order of the files you have selected, click the **Write to DV Tape** button. While files are writing to tape, the button becomes the **Stop Writing to Tape** button, allowing you to stop the writing to tape procedure.

   The files will begin to write to tape in the exact order you have set in this dialog box, and a preview appears in the larger preview window.

4. When the write to tape procedure is finished, click the **Cancel** button to close the dialog box.
Setting AVI Profiles

You may set the parameters of DV and Windows AVI profiles. For more information on the individual settings, refer to "Glossary" on page 145 for more information.

DV AVI Profiles

1. While in the Producing Movie process, after you have chosen AVI as your video type, select DV from the AVI Video drop-down menu and select NTSC or PAL from the drop-down menu to the right.

2. Click Settings...

3. The Type tab is the default. Select DV AVI Type I or DV AVI Type II, depending on your preference. Refer to "Type I" and "Type II" on page 149 for more information.

4. Click on the Audio Quality tab.

5. Select Medium audio quality or High audio quality, depending on your preference.

6. Click OK to return to the production process.

Windows AVI Profiles

1. While in the Producing Movie process, after you have chosen AVI as your video type, select Windows from the AVI Video drop-down menu and select the quality from the drop-down menu to the right.

2. Click Settings...

3. The Compression tab is the default. Select a Compression Codec by clicking on the drop-down menu. Refer to "codec" on page 145 for more information.

4. The Key Frame is unavailable to be set. It is defined as a frame in a video sequence that does not require information from a previous frame for decompression. The more the key frames, the better the quality but at the expense of disk space.
5 Click on the Data Rate drop-down menu and select one. The higher kbps, the better quality but at the expense of hard disk consumed.

6 Select the Composition if you only prefer video or audio.

7 Drag the slider to set your Quality.

8 Click on the Video/Audio Settings tab. Refer to "Glossary" on page 145 for more information on specific terms.

9 Select a Frames x per second by clicking on the drop-down menu. The more motion you have in your video content, the higher the frame rate setting should be. The standard TV frame rate (e.g. NTSC) is 30.

10 Select a Video Size by clicking on the drop-down menu.

11 Select a Color by clicking on the drop-down menu.

12 For the Audio Setting, click on the drop-down menu for Format and Attributes and select for each one. PCM is the default. Refer to "PCM" on page 148 for more information. For the attributes, the higher the Hz, the better quality but at the expense of hard disk space.

13 Click OK to return to the production process.
Producing QuickTime Movie Files

1. Click Produce Movie located on the Modes Wheel.

2. Select QuickTime Movie from the Video for General Purposes drop-down menu and click Next.

3. Select the specific profile from the Default, Custom, or All options. Profile properties will be displayed immediately below the chosen profile. If you want...
better resolution or quality but at the expense of hard disk consumed, choose the higher quality profiles.

- Click Details for more specific information concerning a profile.

- To create your own profile, go to "Creating Custom QuickTime Movie Profiles" on page 114.

4 Click Next.

5 For the last step, enter a file name or click Browse to look for the correct directory. After finding the directory and typing in the new file name, click Save.

6 Check your File Details. Click Finish.
Creating Custom QuickTime Movie Profiles

1  Either if you were in the Producing Movie process after you have chosen QuickTime Movie as your video type, or in the Capture Mode and in the process of selecting a profile, to create a custom profile you must first select an existing QuickTime Movie profile that is closely associated with your new profile.

2  Click New... in order to create a new QuickTime profile. A dialog box appears.

3  Type in a profile name and edit the description. For information on the Profile Properties, refer to "Glossary" on page 145 for more information.
4. Click on the Compressor/Video tab.

- Select a compression scheme that best suits your needs for this movie (i.e. higher Fidelity, Speed, or Compression).
- Select a Video Size, Video Type, and Video Quality by clicking on the drop-down menus. Set the Video Key Frame Rate using the arrows.

5. Click OK to return to the production/capture process.

- To select your new profile, select Custom from the profile group menu and then select the profile.
- To edit existing profiles, select the right custom profile and click Edit. Click Delete after you have selected the custom profile you wish to delete.
Producing RealVideo Files

1. Click **Produce Movie** located on the Modes Wheel.

2. Select **RealVideo** from the Video for General Purposes drop-down menu and click **Next**.

3. Select the specific profile from the Default, Custom, or All options. Profile properties will be displayed immediately below the chosen profile. (Editable fields appear in the Properties box.) If you want better resolution or quality but at the expense of hard disk consumed, choose the higher quality profiles.
Click Details for more specific information concerning a profile.

To create your own profile, go to "Creating Custom RealVideo Profiles" on page 118.

4 Click Next.

5 For the last step, enter a file name or click Browse to look for the correct directory. After finding the directory and typing in the new file name, click Save.

6 Check your File Details. Click Finish.
Creating Custom RealVideo Profiles

1. Either if you were in the Producing Movie process after you have chosen RealVideo as your video type, or in the Capture Mode and in the process of selecting a profile, to create a custom profile you must first select an existing RealVideo profile that is closely associated with your new profile.

2. Click New... in order to create a new RealVideo profile. A dialog box appears.

3. Type in a profile name and edit the description. For information on the Profile Properties, refer to "Glossary" on page 145 for more information.

4. Click on the Settings tab.
   - Select a Video Size, Audio Setting, and Target Audience by clicking on the drop-down menus.

5. Click OK to return to the production/capture process.
   - To select your new profile, select Custom from the profile group menu and then select the profile.
   - To edit existing profiles, select the right custom profile and click Edit. Click Delete after you have selected the custom profile you wish to delete.
Producing Movies on a Disc

1. Click **Produce Movie** located on the Modes Wheel.
2. Select **Video for Movie Disc Production**.
3. Select a **Type of Disc** from the drop-down menu and then a video format from the **Country/Video Format of Disc** menu.
4. If you have the PowerDirector Pro version, you will have the option of selecting **Continue authoring and burning steps after movie is produced**. The Disc Wizard will guide you through the remaining steps after you are finished with the basic producing steps.

5. Click **Next**.
6 For the last step, enter a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

![Image of produce movie window]

7 Check your File Details. Click **Finish**.

8 After production is completed, Pro’s Disc Wizard will automatically appear to allow you to select more video files for your movie disc along with the file you just produced. Go to "Authoring: Disc Type and Selecting Media Files" and #3 on page 125 to continue.
After you have completed your movie and have produced it into a file, you are ready to author and burn it on a disc for mass distribution. Just be sure your CD or DVD burner is working properly and you have a supply of format-compatible blank discs to get started. PowerDirector Pro’s Disc Wizard makes authoring and burning an effortless and fun process, which can also be saved for later use. Let’s get started then!
Chapter 10

Starting the Disc Wizard

**Tips:** Click on the helpful questions located on every page of the Disc Wizard for a quick and convenient answer.

1. Click Disc Wizard. After reading the Welcome message, click **Next**.
2. To open an existing project, refer to "Opening Disc Wizard Projects" on page 138 for more information.
3. If you already have a disc image, select **Load an existing movie file** and go to "Loading an Existing Movie File" on page 123. If not, the default **Create new movie** will be selected. Go to "Authoring Your Disc" on page 124. Click **Next**.
Loading an Existing Movie File

1. Select either Load a disc image file or Load a DVD folder. The latter choice is for users who have previously saved a movie file as a DVD folder.

   - Click Browse to find the appropriate disc image and then click Open.

2. Click Next. Go to "Burning Your Disc" on page 134 and #3.
Authoring Your Disc

This process allows you to create personalized menus, slideshows, chapters, and much more for your movie discs regardless of the type of disc you have chosen. The steps below will be divided into authoring sections.

If you have run out of time before completing this movie file, you may save this wizard project. Refer to "Saving and Opening Disc Wizard Projects" on page 138 for more information.

**Tips:** Click on the helpful questions located on every page of the Disc Wizard for a quick and convenient answer.

Authoring: Disc Type and Selecting Media Files

1. After you are finished with the Disc Wizard’s welcome section, you are ready to select the type of disc you would like to create. Select from DVD, VCD, SVCD, and MiniDVD.

2. Click on the drop-down menu of Video Format and select the proper format for viewing (NTSC or PAL) depending on the country it will be played in. Refer to "NTSC and PAL" on page 142 for more information. Click Next.
3. Select your video files for your movie disc. To begin, click **Import media from PowerDirector projects** to import all media files from a specific PowerDirector project. Find and select the project and click **Open**. All of this project’s Library files will be listed for selection.

- Or, you may click on **From Local Disks** to use video files from your local hard disk drive. Click on the drop-down menu to select a drive and its folders will be listed below. Find the right folder and the files.

4. After the media files are listed, select a file and click **Add**.

**Tips:** If you would like to create a DVD/MiniDVD movie with chapters just like a professional DVD Video disc, you must only use one video file. If your movie disc consists of multiple video files or slideshows, continuous playback between these items will not be available. During disc playback, after each file’s or slideshow’s conclusion, the disc will return to the main menu. For VCD/SVCD discs, jumping between chapters during playback, regardless if they are originally set from a single video file or not, are not available.

- To remove, first select a file that you have already added to the right window and then click **Remove**.

5. Click **Next**.
Authoring: Slideshows and Main Menu Order

1 The next step is if you would like to include your own personal photos and images as a slideshow. Select No, I do not want to include slideshows in this movie disc to skip this step and go to #6. Otherwise, click Next.

2 Disc Wizard allows you to create a maximum of 100 slideshows and 256 images per slideshow. First, click Add Slideshow and a dialog box will appear for you to select images. After selecting the images, click Open. A slideshow folder icon, which represents one slideshow, will also be created along with a display of its contents.

3 To add additional images to a slideshow, click a slideshow folder icon and then click Add Image located below the slideshows section. A dialog box will appear. Find and select images you would like to include and then click Open. The images will appear in the Images pane.

- To remove a slideshow folder and all its images, select the folder and click Remove Slideshow.
- Depending on your audience’s screen size and your image’s size, you may click Stretch to Fit. When checked, during your movie disc playback, if your image is smaller than the display window, it will be stretched to fit the window size disproportionate to the original size aspect ratio. If it is not checked, the original aspect ratio will remain intact when it is enlarged.

Note: If your image is larger than the display window, it may also be Stretched to Fit or if not checked, it will be shrunk in proportion to the original size aspect ratio.
After selecting an image, click Rotate Counterclockwise or Rotate Clockwise to modify your images.

After selecting an image, click Move Forward and Move Backward to rearrange the order of your slideshow.

The last slideshow step is to specify the time for each individual slide. Enter the number of seconds in the Time Duration for Each Slide field.

To add music for a slideshow, select a slideshow and then click Slideshow Music. Select the audio file and click Open.

To remove the Slideshow Music file, click Remove Music.

Click Next.

To adjust the main menu order, select a video file/slideshow and click Move Forward or Move Backward. Click Next.

Note: If your movie disc consists of multiple video files or slideshows, continuous playback between these items will not be available. During disc playback, after each file’s or slideshow’s conclusion, the disc will return to the main menu.
Authoring: Chapters and Menus

1. In order to make it easier for your audience to navigate within your movie discs, you could divide your video file into chapters. Click Next if you would like to set chapters. Select No, I do not want to chapters on this movie disc and then click Next. Go to #5.

- The first current file will be displayed in the Preview Window. To preview, refer to "Previewing your Library Files" on page 32 for more information.

Caution: If you are burning a VCD/SVCD disc and want to set chapters, jumping between chapters during playback, regardless if they are originally set from a single video file or not, are not available.

2. Click Add Chapter at the scene where you would like to divide this file into separate chapters. The first scene of this newly created chapter will appear below in the pane when a chapter has been set.

- To remove a chapter, select its thumbnail in the chapters’ window and click Remove Chapter.
- Click Next Chapter and Previous Chapter to navigate among the different files and its chapters or you may click on the chapter thumbnail directly.
You may also detect scenes from your file with the Disc Wizard. Simply, click Detect Next Scene. The first frame of the next scene will be displayed. If you want to set a chapter here, click Add Chapter. If not, continue detecting to other scenes. (Refer to "Detecting Scenes" on page 35 for more information on this great new feature for PowerDirector 2.0)

- To modify the sensitivity of your scene detections, click Detect Scenes Options. Drag the Sensitivity slider or click Increase/Decrease Sensitivity. The more sensitive the setting, the more scenes it will detect which will generate more video files.

The Detection Method section is for captured video content that has been imported into the Library. Use the default unless you have a DV AVI format file that contains multiple timecodes (i.e. resetting of timecodes are automatically set when you start and stop recording) and you wish to split up your files in this manner, select Detect by changing of timecodes.

**Note:** If you have selected Detect by changing of timecodes, in essence, PowerDirector will not be performing the scene detection feature, for scenes that are detected will rely solely on the DV tape’s changing of timecodes, which is ultimately dependent on the DV tape itself.

4 Click Next when you are done.

5 You may wish to include menus in your movie disc for that professional look and to provide your audience with an organized and flexible palette to work from. Select DVD/VCD/SVCD with Menus. If you do not wish to include menus, click Next and go to "Authoring: Previewing Content" on page 132.
Click on the drop-down menu in order to select a proper theme for your menu. Menu templates will be displayed according to the theme you selected. Click **Next** after selecting one.

**Note:** If you previously had selected another template, a dialog box will appear to verify that you want to apply the new template you have selected. Click Yes to apply or No to revert to the existing template.
The next step allows you to modify all the menu options imaginable. Notice the right window and the icons that are aligned on its right in a vertical fashion. The default is **Buttons Per Page**. Select the number of buttons per page.

![Image of Modify Menu Options window](image)

**Note:** If your movie disc consists of multiple video files or slideshows, and you have set chapters for your video files, these chapters will be combined with other files’ chapters and slideshows in the menus. Even though they are combined together in the main menu, continuous playback between video files and slideshows will not be available. For VCD/SVCD discs, jumping between chapters during playback, regardless if they are originally set from a single video file or not, are not available.

Click on the other tabs located beside the right window after you have selected the Buttons Per Page. Select an option for each tab and repeat this procedure for all the following tabs:

- **Buttons Per Page** determines the number of maximum buttons found on one menu page and determines the selections found in the Style tab.
- **Style** determines the style you would like to adopt for this particular menu page. This will depend on the Buttons Per Page selection.
- **Background** allows you to customize background images for this menu page. Click **Add Personal Photo as Background** and you will be allowed to select your own personal background image from your HDD. Find and select the file. Then click **Open**. To delete a customized background image (default images may not be deleted), click the Background tab first and then select a background image that you previously added. Finally, click **Delete Custom Background**.
Chapter 10

**Note:** The size of this image file will be resized during playback (stretched to fit) depending on the disc type you chose. Refer to the table at “NTSC and PAL” on page 142 for more information.

- **Frames** selections are for the visual representations of the individual chapters or slideshows.
- **Navigational Buttons** will include Home, Next and Previous if your disc possesses multiple menu pages.
- **Graphic Buttons** are for chapter selections that may be represented by static images instead of the chapter’s thumbnails.

- To edit text, click in the text boxes twice and a cursor will flash. Begin typing. To set its format, select the text and click on **Set Text Format** to format your menu’s text. Click **OK**.

- Click **Next Page** and **Previous Page** to set other menu pages (if applicable). For example, if you have 30 chapters and 3 slideshows, the total number of buttons will be 33. If the maximum number of buttons for every menu page is 10, you will have a total of 4 menu pages (10 per page with 3 remaining on the 4th page).

- Click on **Background Music** to select an audio file to be played in the background for your menus. Select the audio file and then click **Open**.
  - To remove an audio file, click **Remove Music**.

9. Click **Next** after you are finished.

**Authoring: Previewing Content**

1. To preview your content before you burn it or save it as a movie file (disc image), click **Next**. If you would like to burn right now, select **No, burn disc now**, click **Next** and go to “Burning Your Disc” on page 134.

2. Now, put the remote control to its full use during the preview. Click **Toggle View** to switch to a full screen preview window. This is where you may click and drag the remote control to any position on the display window. Click Toggle View again to minimize the screen.
3 Use the remote control’s menu arrows in order to select the proper file, chapter, or slideshow and click Enter to begin previewing. You may also click each individual selection directly to begin playback without using the remote control.

- To return to the menu, click Menu.
- Utilize the navigational functions such as Play, Pause and Stop during the preview.
- Click Next Chapter and Previous Chapter to navigate faster and jump to other chapters.

4 After you are satisfied with the preview, click Next to continue to the final stage.

**Note:** The disc preview is only a simulation of the actual content that will be burned/produced. The video size and any other effects may be slightly dissimilar.
Burning or Saving Your Movie

You have reached the final stage of distributing your masterpiece for public consumption. You may either burn to your disc or save it as a movie file (disc image).

*Caution:* If you are using CD-R discs (even multi-session discs), they must be completely new and blank.

Burning Your Disc

1. The first step of the final stage is if you would like to burn it on your disc or to save this as an image file onto your hard disk drive. Select **Burn disc now**. To **Save to hard disk drive**, select it and refer to "Saving as a Movie File" on page 136.

2. Check **Include PowerDVD runtime on disc** if you would like to make the autoplay feature available for your movie disc so that it will play automatically on any computer even without a DVD playback software. Click **Next**.

3. Select the proper **Recording drive** by clicking on the drop-down menu.

4. Enter a label for this movie disc in the **Volume Label** field.
5. Enter the number of copies you would like to make. During the burning process, after one movie disc has been completed, the Disc Wizard will notify you for the next burning session so prepare all your discs beforehand!

6. Select the **Recording speed** by clicking on the drop-down menu.

7. Checked as default are two options listed below:
   - **Enable disc burning simulation** is a pseudo-burning session that undergoes the burning process through simulation for testing.
   - **Include buffer under-run protection** is to create a buffer for the burning process that maximizes system stability during the burning process and allows users to multitask. Without the buffer under-run protection, stability is minimized and multitasking would prove difficult.

   To erase all the content on your rewritable disc before burning, click **Erase Disc Content**.

---

**Note:** If you are using a CD-RW disc, you will be prompted to erase all data on your disc before proceeding. Click Yes.

8. To check details of your drive, click **Drive Info**.

9. Click **Burn it** to begin writing to your disc.

10. To start another job after this one is complete, click **Return to Start**. Otherwise, click **Finish**.
Saving as a Movie File

1. The first step of the final stage is if you would like to burn it on your disc or to save this as an image file onto your hard disk drive. Select **Save to hard disk drive** and click **Next** if you have not already done so.

2. Depending on your disc type, only **Save as a disc image file** will be available if you are burning a VCD or SVCD in the future. For DVD types, select the above or **Save as a DVD folder**.
Enter the **Volume Label** if you wish.

**Note:** When saving as a disc image, it will be in a proprietary format only the Disc Wizard may read and write to disk (i.e. burn) in the future. When saving as a DVD folder, all files will be in a standard format that any disk writer software application may read and write to disk (i.e. burn) in the future.

3. Enter the directory path and a new file name for this disc image. Or click **Browse** to find the proper directory and then click **Save**. Click **Next**.

4. Click **Abort** to abort the process.

4. To start another job after this one is complete, click **Return to Start**. Otherwise, click **Finish**.
Saving and Opening Disc Wizard Projects

If you are the perfectionist that people have claimed you to be, and you want to create a spellbinding movie file (disc image), you may save your Disc Wizard project (.CTR) for later use or reference.

1. At any step in the Disc Wizard, simply place your cursor on the Show Menu tab (icons will vary depending on the last performed action). The menu will be displayed.

2. Select Save As... A dialog box will appear. Find the folder and then name your wizard project and then click Save.

Opening Disc Wizard Projects

To open a project, place your cursor on the Show Menu tab and select Open. Find and select the CTR project file. Then click Open and you will be at the exact step where you saved the project the last time.
CHAPTER 11: TECHNICAL SUPPORT

Before asking CyberLink Corp. for technical support, please refer to this user’s guide or online help for more information. You may also contact your local distributor/dealer. If your problem is still not resolved, the following sections provide ways to obtain technical support.

Web Support

Solutions to your problem are available 24 hours a day at our Web sites in Taiwan, USA, or Japan:

- support.gocyberlink.com
- www.gocyberlink.com
- www.cli.co.jp

You may also find solutions in the FAQ section or at our Web sites. In addition to frequently asked questions, we also provide troubleshooting techniques, the latest in product news, and other relevant information.

Fax Support

In order to answer your technical questions as quickly as possible, you may fax us at: (886) 2-8667-1467.

**Note:** Technical support is only offered to registered users, so please make sure to jot down your CD-Key located on your CD case when visiting our Web sites or faxing.
Telephone Support

You are welcome to call the CyberLink’s Technical Support Hotline at:

(886) 2-8667-1298

Phone support hours are Monday to Friday, 9:00 AM-5:00 PM (GMT+8:00) Taiwan local time excluding holidays. When calling for support, please have your computer ready and provide us with the following information:

- your registered CD-Key
- the product version
- Windows’ OS version
- hardware types (capture card, sound card, VGA card) and their specifications
- warning messages displayed
- detailed problem description and when it occurred

Note: Technical support is only offered to registered users, so please make sure your CD-Key is ready when calling.
APPENDIX

What Is MPEG?

MPEG, simply, is an acronym short for the Moving Picture Experts Group which belongs to the family of ISO/IEC standards (International Organization for Standardization and International Electrotechnical Commission). It is a compression technology for digital video and audio signals intended for consumer distribution. Included in the MPEG family are:

- MPEG-1 (Audio/Video)
  - MP3 or MPEG-1 Audio Layer 3 (Audio)
- MPEG-2 (Audio/Video)
- MPEG-4 (Interactive Multimedia System)
- MPEG-7 (Multimedia Database & Retrieval)

MPEG technology is defined as a bit-stream representation for synchronized digital audio and digital non-interlaced or interlaced (MPEG-2 includes both) video compressed to fit into a certain bandwidth:

- MPEG-1 -- 1.5-4-0 Mbps (megabits per second)
- MPEG-2 -- 4.0-10.0 Mbps

MPEG is responsible for multiplexing and synchronizing one video stream with a single or multiple audio streams. MPEG-1 was designed to reproduce VHS/VCR quality in a digital format, while the MPEG-2 concept, similar to MPEG-1, is intended to cover a wider range of applications including DVD quality and its primary goal of an all-digital transmission of broadcast TV at coded bitrates between 4 and 9 Mbps.
NTSC and PAL

The NTSC (National Television Systems Committee) and PAL (Phase Alternating Line) are television standards used for commercial television broadcasting around the world. Both NTSC and PAL use interlaced content at 30 frames per second (i.e. 60 fields) and 25 frames per second (i.e. 50 fields) respectively.

Because fields in interlaced signals are independent of other fields within a given frame, problems arise when two fields containing different imagery data are interleaved for display on non-interlaced computer monitors. When video imagery with superfluous movement is displayed, it usually causes motion artifacts (visual imperfections) and is why deinterlacing in bob mode with PowerDVD XP is needed. DVD titles whose content originates directly from films produced from Hollywood studios (24 frames/second) won't possess motion artifacts.
The Digital Video Universe

Profit outlooks and shrinking demand in the technology industry notwithstanding, the digital video revolution is well underway. There are still home videos to be edited, videos to be distributed, and full length movies to be produced. In previous generations, video editing and recording was accomplished through analog means by video professionals who had access to high-priced machinery and video equipment. Thus, many of those who wished to edit home footage or videos, if they were lucky enough to have it recorded in the first place, never had the chance to display their creative prowess when it came to video editing unless it involved enrolling in film schools and obtaining access to production studios.

When the computer descended upon our lives and immersed itself in our world, it was only a matter of time until processing speeds were incredibly fast and disk space was vast enough to begin editing video at home with software applications that didn’t require expensive video specialists, equipment or any other gadgets.

And coinciding with the computer industry’s major influence was the birth of the DV (digital video) format, an international standard intended for consumer use, back in 1995.

The DV Format: A Brief History

Like a seamless emergence and natural coalescence with desktop video editing, the advent and proliferation of DV camcorders were sure to spark continued interest in the infinite possibilities of digital video. What began back in 1995 and a DV format agreement reached by a consortium of companies that included Hitachi, Ltd., Sony Corp, Sharp Corporation, Thompson Multimedia, Mitsubishi Electric Corporation, Victor Corporation of Japan (JVC), Matsushita Electric Industrial Corp. (Panasonic), Philips Electronics, Sanyo Electric Co. Ltd., and Toshiba Corporation, is still being ironed out until this day in terms of a consensual format.

The frontrunners at the time and still are until this day, are Sony and Matsushita (Panasonic), which beat out the competition with their consumer releases hitting the market first. Soon after though, the format wars began with professional DV variants such as DVCAM (Sony) and DVCPRO (JVC) despite the DV format agreement. Luckily, the basic DV format is still intact, but other factors were altered (i.e. tape type, track pitch and width) so we are still left with backward-compatible formats or incompatible formats between models from differing companies. Hopefully, this won’t impact or trickle down to the consumer segment anytime soon.

What exactly is the DV format then? To start with, it has a 5:1 compression ratio and its compression technology is quite similar to MPEG (e.g. DVD Video format).

Tips: For more information on MPEG, refer to "What Is MPEG?" on page 141.
Appendix

The difference is that it relies more on intraframe compression where each compressed frame will depend entirely on itself and not on data from preceding or following frames like MPEG. However, the DV format does incorporate the use of adaptive interfield compression where two extremely similar interlaced fields of a frame will be compressed together to save space.

The analog generation is slowly witnessing its demise. There is still room left for analog technology, but as the DV format perfects its compression technology and enhances their non-linear editing (NLE) friendliness, the analog generation will soon be outdated, fainting memories from a bygone era. Add to this the continued popularity of video editing software and the uncompromising blazing speed of computer processing power, and the perfect union between DV recording and editing couldn’t be any more natural or fitting.

FireWire

In the early courting stages of video editing software and DV format recording, there had to be an intermediary between the two technologies to make it a success, because as you know from analog transference, there is always data lost from the original source. FireWire, or IEEE-1394, is this unerring technology when it comes to data loss, as in “lossless” transfer. A serial data transfer protocol and interconnection (bi-directional) system, FireWire transmits digital video (DV) offering a higher transfer rate and incorporating the use of hot-plugging technology (i.e. connecting and disconnecting without shutting down the host computer).
GLOSSARY

ASF  Short for Advanced Streaming Format, a streaming multimedia file format developed by Microsoft for Windows 98. Term is currently used interchangeably with WMA and WMV.

bitrate  Bitrate denotes the average number of bits that one second of video/audio data will consume.

CD-R & CD-RW  CD-R stands for "CD-Recordable". Recordable CDs are WORM (Write Once, Read Multiple) media that work just like standard CDs but may only be written to once unlike CD-Rewritable (CD-RW) discs, which may be reused. However, its main disadvantage is that it doesn't work in all players. CD-Rewritable drives are able to write both CD-R and CD-RW discs and all CD recorders can read CDs and CD-ROMs. Volume, of 650 MB, is just like any other CD-ROM disc.

chapter  For DVDs, chapters make up one title. There are roughly 20+ chapters for the entire length of one DVD movie.

codec  Short for video COmpression and DECompression. Each codec uses a different algorithm to compress and decompress video data. Without codecs, storing and playing back digital video would be impractical. Common codecs include Indeo, Cinepak, RLE, MS Video 1, and MPEG.

deinterlace  Deinterlaces interlaced video content, especially from TV signals and is mainly used to display interlaced video programs on non-interlaced computer monitors (see "interlaced video content" on page 147 for more information).

DivX  A digital video codec that uses MPEG-4 technology. This file format compresses high-quality video to a small enough size that makes sending video over the Internet a realistic option for many users.

DSL  See xDSL.
**Glossary**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DV</strong></td>
<td>Digital Video. Refers to the capturing, manipulation and storage of video in digital formats. The DV format is an international standard intended for consumer use created back in 1995 by a consortium of companies.</td>
</tr>
<tr>
<td><strong>DVD</strong></td>
<td>Digital Versatile Disc. DVD is a high capacity CD-size disc for video, multimedia, games and audio applications.</td>
</tr>
<tr>
<td><strong>DVD-ROM</strong></td>
<td>A read-only format, it is similar to the CD-ROM format for compact discs but holds up to 4.7 GB for single-side and single-layered discs. More common today is the single-sided and dual-layered 8.5 GB discs. Further down the scale is double-sided and single-layered 9.4 GB discs and double-sided and dual-layered 17 GB discs.</td>
</tr>
<tr>
<td><strong>DVD-RW</strong></td>
<td>DVD-RW (formerly DVD-R/W and also briefly known as DVD-ER) is a phase-change erasable format. Developed by Pioneer and based on DVD-R, it uses similar track pitch, mark length, and rotation control. DVD-RW is playable in most DVD drives and players. Capacity is 4.7 billion bytes and can be rewritten about 1,000 times.</td>
</tr>
<tr>
<td><strong>DVD+RW</strong></td>
<td>DVD+RW, supported by Philips, Sony, Hewlett-Packard, etc., is an erasable format based on CD-RW technology. It is not supported by the DVD Forum (even though the DVD+RW companies are members), but the Forum has no power to set standards. DVD+RW drives will read DVD-ROMs, CDs, DVD-Rs and probably DVD-RWs, but will not read or write DVD-RAM discs. The drives can also write CD-Rs and CD-RWs. DVD+RW discs, which hold 4.7 billion bytes per side, should be readable in most existing DVD Video players and DVD-ROM drives. It can be rewritten about 1,000 times (down from 100,000 times in the original version).</td>
</tr>
<tr>
<td><strong>flip video</strong></td>
<td>This option is for certain video formats (such as YUY2) provided by some hardware capture devices which will might be displayed as upside-down during recording.</td>
</tr>
<tr>
<td><strong>fps</strong></td>
<td>Frames Per Second. A measure of how much information is used to store and display motion video. The term applies equally to film video and digital video. Each frame is a still image; displaying frames in quick succession creates the illusion of motion. The more frames per second (fps), the smoother the motion appears. In general, the minimum fps</td>
</tr>
</tbody>
</table>
needed to avoid jerky motion is about 30. Some computer video formats, such as AVI, provide only 15 frames per second.

**frame rate**

For video content, the frame rate measures how many still frames per second. The higher the better when capturing video content with motion.

**GOP**

Group of Pictures. A MPEG compression technology, the GOP concept reduces the temporal redundancy across frames (from frame to frame) for video content and consists of I, B, P frames.

**hue**

Is an attribute of colors that permits them to be classed as red, yellow, green, blue, or an intermediate between any contiguous pair of these colors.

**I-frame**

A.k.a. intra pictures, I-frame is typically the first frame of each GOP (apart of video compression technology used by MPEG), is moderately compressed, and serves as the reference points for random access and can be likened to images.

**interlaced video content**

Describes video content within a given frame where there are 2 imagery data fields, even and odd, that is scanned separately (e.g. NTSC and PAL television signals). This usually poses a problem when interlaced content meets non-interlaced mediums like computer monitors, which only displays non-interlaced content.

**ISDN**

Integrated Services Digital Network. Provides a user up to 56 kbps of data bandwidth on a phone line that is also used for voice, or up to 128 kbps if the line is only used for data.

**kbps**

Kilobits per second. See bitrate.

**kHz**

Kilohertz. Hertz (Hz) is a unit of frequency equal to one cycle per second. One kHz is 1000 complete cycles per second.

**LAN**

Local Area Network. A computer network that spans a relatively small area. Most LANs are confined to a single building or group of buildings and mainly connect workstations and personal computers.

**MiniDVD**

MiniDVD is a variation of DVD Video, where a true DVD (including menus and high-resolution MPEG-2 video) is placed on CD-R media.

**MBR**

Multibitrate codecs allow several streams of different bitrates to be bundled into one file. The streaming server then
communicates with the end user's media player to determine the optimum speed for delivery.

**mono**
Mono is a single audio channel for lowest bitrate consumption.

**MPEG**
Moving Picture Experts Group. A family of international standards used for coding audio/video information into digital format. Currently, MPEG-2 is the standard for digital video formats and MP3 for strictly digital audio formats.

**non-interlaced video content**
Describes video content within a given frame that does not consist of distinct imagery data fields. (e.g. computer monitors)

**noise removal**
Removes video artifacts such as white noise from video signals.

**NTSC**
National Television Systems Committee. Is a standard format adopted by the FCC for television broadcasts in the United States, Japan, Canada, and Mexico. Specifications: 525 lines of resolution per frame at 30 fps.; 60 Hz field frequency; requires a 6 MHz analog channel for transmission.

**PAL**
Phase Alteration Line. Is the standard format for television broadcasts in Germany, Great Britain, South America, Australia, and most of Western European and Asian countries.

**PCM**
Pulse Code Modulation. Is a sampling technique for digitizing analog signals, especially audio signals. PCM samples the signal 8000 times a second; each sample is represented by 8 bits for a total of 64 kbps. There are two standards for coding the sample level. The Mu-Law standard is used in North America and Japan while the A-Law standard is use in most other countries.

**resolution**
A synonym for sharpness in regards to imagery detail, it is measured in lines or pixels.

**sampling rate**
Sampling rate determines the sound frequency range (corresponding to pitch), which can be represented in digital waveform. The range of frequencies represented in a waveform is often called its bandwidth.

**saturation**
Is chromatic purity: freedom from dilution with white.

**smoothing**
Smoothes out image if you find video content is too fine and on the grainy side.
stereo  
Short for stereophonic and developed in the 1950’s, it constitutes sound reproduction using two independent audio channels.

SVCD  
Conceived of in China, this format’s quality falls in between that of VCD 2.0 and DVD.

SVRT  
Smart Video Rendering Technology. A proprietary CyberLink technology, SVRT saves vast amounts of time when producing movies that contain compressed MPEG files because it only renders edited portions. This preserves the quality of unrendered video portions of the original MPEG files.

title  
DVDs consist a maximum of 99 titles for every DVD Video. Titles will consist of chapters.

Type I  
Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single AVI stream. It offers better compression, but is newer, and therefore compatible with fewer systems than Type II.

Type II  
Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single video stream and 1-4 audio streams to store DV data. It offers wider compatibility, but uses an older compression than Type I. This format requires slightly more processing time to split the video/audio stream while capturing.

VCD  
Video Compact Disc. Generally for video applications employing MPEG-1 technology, video quality is not as detailed as DVD and has similar technology to that of audio CDs.

video overlay  
Video overlay is the ability to superimpose computer graphics over a live or recorded video signal and store the resulting video image on hard disk.

Windows Media Format  
This format is optimized for streaming and playing back audio, video, and script data and is primarily used in streaming presentations over the Internet. The main format used is .WMV in combination with Microsoft’s Windows Media Player.

Windows Media Services Server  
The Windows Media Services server offers the ability to provide multimedia content to a large number of clients using .WMV, .ASF, .WMA, .MP3 and .WAV formats. It is for the expanded use of streaming media such as live broadcasting.
and intelligent streaming and is, by default, the best way to stream media since it was designed especially for streaming. It also provides sufficient tools and support for traffic management and broadcasting streaming services. This differs from HTTP (Hypertext Transfer Protocol) streaming, which is directly streamed from Web servers.

**WMA**

Windows Media Audio. A Windows Media proprietary streaming audio format typically used to download and play files or to stream content.

**WMV**

Windows Media Video. A Windows Media proprietary streaming audio/video format typically used to download and play files or to stream content and is the main streaming format used for Microsoft's Windows Media Player.

**xDSL**

Refers collectively to all types of Digital Subscriber Lines, the two main categories being ADSL and SDSL. Two other types of xDSL technologies are High-data-rate DSL (HDSL) and Symmetric DSL (SDSL). DSL technologies use sophisticated modulation schemes to pack data onto copper wires. They are sometimes referred to as last-mile technologies because they are used only for connections from a telephone switching station to a home or office, not between switching stations.
INDEX

A

advanced settings 100
altering speeds. See Speed Mode
analog
camcorders 3, 51
devices 1
generation 144
signals 148
video capture
See Capture Mode, analog video capture
antenna 53
applying
image color filters 92
eyedropper tool 92
in modes. See specific mode for
details
to Storyboard 11, 30, 33
ASF format 145
audio capture. See Capture Mode, audio capture
audio clips, adding to Storyboard 83
audio compression rate 101
Audio Mode
adding audio files 23, 24, 84, 86
applying 85
clearing effects 23, 24, 85
Master Audio. See Master Audio
removing audio files 23, 24
reverting 23, 24, 85
trimming audio files 24
applying 85
visual overview 12, 24
volume mixing 23, 24, 85
audio streams 141

AVI format 93, 147
movies. See producing, AVI movies
profiles 106
DV group 106
video for general purposes 105
Windows group 106
setting profiles of 110
audio setting 111
color 111
composition 111
compression 110
compression codec 110
data rate 111
frames per second 111
key frame 110
quality 111
video size 111
writing in 105

B

background color 76
bandwidth 148
basic procedures 27
batch capturing 63
See also Capture Mode, DV capture
bitrate 145
buffer 49, 102
burning your disc 134
camcorders
DV 3, 51, 57
advent of 143
batch capturing from. See batch capturing
Camera mode 57, 58
VCR mode 57, 60, 63
Camera mode 58
capture cards 3, 51
selecting source of 53
capture destination. See preferences, capture destination
capture file name 45
Capture Mode
analog video capture 13
audio capture 13, 55
audio CD source 55
device setup 55
input setup 55
profile setup 56
setup 55
capturing selection 53
capturing video and audio 52
DV capture 13, 57
adding batch task 17, 65
batch capturing 15, 17, 63
Camera mode 58
current time 15
instant capturing 15, 17
marking in 17, 65
marking out 17, 65
profiles 54, 58, 61, 64
removing batch task 17, 66
seek tape 15, 17, 61, 64
shuttling 15, 17, 61, 64
starting batch task 17, 65
total time 15, 62
using non real-time 15, 17, 57, 58, 61, 64
using real-time 15, 17, 57, 58, 61, 64
VCR mode 60
visual overview 12, 13
capture performance 48
capture/export preferences. See preferences, capture/export
capturing files
scenes detection 48
CD-R 145
CD-RW 145
clearing. See specific mode for details
closing PowerDirector 27
codec 145, 147
compression 110
Color Boards 34
new 34
restoring default in the Library 9, 34
showing in Library 9, 34
composition 111
compression 101, 145
audio rate 101
codec 110
setting 110
techniques of 102
technology of 93, 147
video rate 100
country of disc 119
crop resize option 69, 70
custom MPEG profiles. See MPEG, custom profiles of
size limit 56, 59, 62
time limit 56, 59, 61
video capture
analog video 53
antenna 53
CATV 53
device setup 53
setup 53
snapshot 56
tuner source 53
visual overview 12, 13

C

C
D

data packets 102
data rate 111
deinterlacing 100, 145
deleting
  clips from Storyboard 39
  files from Library 31
  MPEG profiles 101
  QuickTime profiles 115
  RealVideo profiles 118
detected scenes
  merging 37
  removing 37
detecting scenes 8, 30, 35
  advanced settings in 36
  by changing timecodes 36
  ignoring fade ins 36
  ignoring flashing lights 36
  in capture mode 48
  setting sensitivity 35, 129
  through changing of timecodes 129
digital camera 3, 51
disc wizard
  adding slideshows 126
  adjusting main menu order 127
  buffer under-run protection,
    including of 135
  burning your disc 134
  creating new movie 122
  detecting scenes in 129
  disc image file, loading of 123
  discs with menus 129
  DVD folder, loading of 123
  enabling disc burning simulation 135
  importing from projects 125
  loading existing movie file 122, 123
  menu options 131
  menu templates 130
  opening projects 138
  PowerDVD runtime, including of 134
  previewing content 132
  saving as movie file 136
  saving projects 138
  selecting disc type 124
  selecting media files 125
  setting chapters 128
  starting 122
  video formats 124
  visual overview 12
display preferences. See preferences, display
DSL 145
DV 144, 146
camcorders 3
  buffer time 49
  Camera mode. See camcorders, DV
  capturing from 57
  DVCAM format 143
  DVCPRO format 143
  VCR mode. See camcorders, DV
  See also camcorders, DV
Capture Mode of
  visual overview 14, 16
  See also Capture Mode, DV capture
  capturing source of 13
  format of 143
  parameters setup 49
  profiles 106
  tape
    previewing when writing 28
    timecode 15, 17, 61, 64
    writing multiples files to 28
    writing to 28, 105, 106, 108
  universe of 143
DV AVI
  detecting scenes with 36, 129
  introduction of 93
  profiles of 59
  used optimally with SVRT 106
  writing to tape 28, 108
DV VCR 51
DVD 146
DVD+RW 146
DVD-ROM 146
DVD-RW 146
E

edit preferences. See preferences, edit
editing MPEG profiles 101
editing QuickTime profiles 115
editing RealVideo profiles 118
Effects Mode
  applying 76
  background color setting 76
  clearing effects 21, 76
  effects settings table 74
  foreground color setting 76
  linked settings for 76
  marking in 76
  marking out 76
  reverting 21, 76
  supplying video effects 73
  visual overview 12, 21
end of file 11, 33, 68
exiting PowerDirector 7, 27

F

file formats, supported 4
files
  importing into Library 30
FireWire 3, 51, 144
flip video 146
foreground color 76
frame rate
  display preferences 47
    See frames per second.
  frames per second 100, 146

G

general preferences. See preferences, general
GOP 147
grid lines 89

H

hardware requirements. See system requirements, hardware
Help 29
hold time 79
hotkey list 41
hue 147

I

I-frame 147
image color filters. See applying, image color filters
importing files. See Library, importing media
input file formats 4
intelligent streaming 150
interlaced video content 141, 142, 147
    See also non-interlaced video content
i-Power 7, 29
ISDN 147

K

kbps 147
key frame 110
kHz 147

L

LAN 147
letterbox resize option 69, 70
Library
  deleting files from 31
  displaying as file details 8
  displaying as large icons 8
  importing directory 8, 30
  importing files into 30
  importing media 8, 28, 30
  new Color Boards in 34
  previewing files in 32
removing from 30  
restoring default Color Boards in 34  
Show Audio icon 8  
showing all audio files 8, 30  
showing all image files 8, 30  
showing all media files 8, 30  
showing all video files 8, 30  
showing Color Boards 34  
visual overview 8  

custom 100  
video for general purposes 94, 97  
used optimally with SVRT 95  
MPEG-1 149  
producing movies of. See  
producing, MPEG-1 movies  
MPEG-2 148  
producing movies of. See  
producing, MPEG-2 movies  

marking in  
See Capture Mode, DV capture  
See Effects Mode, marking in  
See Titles Mode, marking in  
marking out  
See Capture Mode, DV capture  
See Effects Mode, marking out  
See Titles Mode, marking out  
Master Audio 10  
clearing effects 87  
fade in 85, 87  
fade out 85, 87  
repeating 87  
reverting 87  
trimming in 87  
applying 87  
volume mixing 87  
Master Watermark 10, 91  
applying color filter in 91  
MBR 147  
merging detected scenes 37  
minimizing PowerDirector 7, 27  
Modes Wheel  
visual overview 12  
Modes. See specific mode  
mono 148  
movies files  
See also disc wizard, loading  
existing movie file  
MPEG 93, 141, 147, 148  
audio compression setting of 101  
 profiles 95, 96, 98  

networks  
ISDN 147  
local area 147  
protocols 102  
new project 28  
next frame 11, 33  
noise removal 100, 148  
non-interlaced video content 141, 142, 148  
non-linear editing 144  
NTSC 142, 148  

opening  
PowerDirector projects 28  
wizard projects 138  
output file formats 4  
overlay. See video overlay  

PAL 142, 148  
parameters setup. See DV, parameters setup  
pausing 11, 15, 33, 68  
PC camera 3, 51, 56  
PCI  
capture cards 3, 51  
PCM 148  
Picture-in-Picture Mode
applying image color filter 22, 25, 92
clearing effects 22, 89
editing video in 90
keeping aspect ratio 89
reverting 22, 89
selecting 88
transparency setting 89
visual overview 12, 22
playing files 11, 15, 33
playing movie 10, 40, 50
ports 53
PowerDirector overview 6
preferences 44
capture/export
destination of 48
DV parameters setup 49
display
Library files tool tips 47edit
applying clip preferences 46
default durations 46
removing clips 46
file directory and name
default export directory 44
default import directory 44
frame rate 47
general
capture file name 45
preview
clip 50
window size 50
scene detection in capture mode 48
Preview Mode 12
preview preferences. See preferences, preview
Preview Window 11
previewing
during production 10, 40, 50
in Preview Window 33
in Video Viewer 32
Library files 32
preferences. See preferences, preview
the Storyboard 30
title effects 79
transitions 81
when writing to DV tape 28, 107
previous frame 11, 33, 68
producing
AVI movies 105
from Storyboard clips 38
movies on a disc 119
MPEG-1 movies 94
MPEG-2 movies 97
preferences 50
profiles. See profiles
visual overview 12
Windows Media movies 102
profiles
AVI. See AVI format, setting profiles of
DV AVI 59
MPEG. See MPEG, profiles
video for general purposes 54, 58, 61, 64
video for movie disc production 55, 59, 61, 64
Windows Media. See Windows Media, profiles
properties of project 28

Q
QuickTime
profiles 113
custom 114
QuickTime format
profiles
video for general purposes 112

R
RealVideo
profiles 117
custom 118
RealVideo format
profiles
video for general purposes 116
recent files 28
recently used files 45
recording 11, 15
   audio CD 56
   Capture Mode. See Capture Mode, recording upside-down 146
removing
   audio files. See Audio Mode, removing audio files
   batch task. See Capture Mode, DV capture
   detected scenes 37
   titles. See Titles Mode, removing titles
resizing
   images. See Trim Mode, for image files
   video. See Trim Mode
   resizing resolution 148
reverting. See specific mode for details

S
sampling rate 148
saturation 148
saving
   PowerDirector projects 28
   wizard projects 138
scenes
   detecting by changing timecodes 36
   See also detecting scenes
seek tape. See Capture Mode, DV capture
setup
   See Capture Mode, audio capture
   See Capture Mode, profile setup
   See Capture Mode, video capture
shuttling 15, 17, 61
size limit. See Capture Mode, size limit
slow motion. See Speed Mode
Smart Video Rendering Technology 1, 93, 95, 97, 106
smoothing 100, 148
snapshot 15, 18
   preferences 49
to clipboard 49
to file 49
to wallpaper 49
sound cards 102
speakers 102
Speed Mode
   applying 72
   audio settings of 72
   clearing effects 19, 72
   decreasing speed 19, 71
   increasing speed 19, 71
   preserving original audio speed 72
   reverting 19, 72
   synchronizing audio with video 72
   visual overview 12, 19
speed quality indicator 100
splitting video
   in Trim Mode 69
   while detecting scenes 37
start of file 11, 33, 68
stereo 149
stopping 11, 15, 17, 33
Storyboard
   activating Master Audio 10
   activating Master Watermark 10
   applying audio files to 38
   applying to. See applying, to Storyboard
   copying from 29, 39
   cutting from 29, 39
   deleting from 29
   display preferences 47
   functions of 38
   moving clips 38
   removing clips 39
   going to 39
   pasting on 29, 39
   playing movie 10, 40
   preferences 50
   scrolling left 10
   scrolling right 10
   visual overview 10
streaming
   ASF format 145
   format of 150
   intelligent streaming. See intelligent
streaming requirements for server 3 technology 102 stretch resize option 69, 70 supported file formats 4 system requirements 3

t

technical support 139 time limit. See Capture Mode, time limit time slider 18, 33, 68 timecode. See DV, tape Titles Mode adding titles 20, 78 applying 80 clearing effects 20, 80 marking in 20, 79 marking out 20, 79 removing titles 20, 80 reverting 20, 80 selecting title effects 79 hold time 79 previewing 79 setting fonts 20, 78 showing all titles 80 visual overview 12, 20 Transitions Mode applying 82 clearing effects 25, 26, 82 previewing 81 reverting 25, 26, 82 selecting of 81 transition length 82 visual overview 12, 26 Trash Can using in Library 31 Trim Mode applying 69 clearing effects 18, 69 for image files 70 clearing effects 70 duration setting 70 resizing 70 reverting 70 marking in 18, 68 marking out 18, 68 resizing video 68 reverting 18, 69 snapshot 15, 18 splitting video 69 total trim time 18 visual overview 12, 18 trimming audio files. See Audio Mode, trimming audio files files. See Trim Mode TV antenna 53 broadcast 141 producing for 106 capturing from 53 frame rate 111 station logos 91 TV Safe Zone 89 type of disc 119

U

USB 3, 51

V

VCD 149 VCR 3 video capture devices optional list 3 selecting of 53 video compression rate. See compression, video rate video editing in previous generations 143 software 1, 93, 144 video effects. See Effects Mode video format of disc 119, 124 video overlay 48, 149 video scaling 102
video size 100, 111, 115, 118
Video Viewer 32
viewing scenes 30

W

watermark. See Master Watermark
Web server 102, 150
Windows Media 102, 149
   Audio (WMA) 150
   Player 102, 149, 150
   profiles 102, 103
      video for general purposes 103
   Services server 149
   Video (WMV) 150
Windows OS
   system requirements. See system requirements
WMA 150
WMV 150
writing
   multiple files to DV tape 28
to DV tape.
   See DV, tape
to tape
   previewing 28

X

xDSL 150